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1 TESLA: An Introduction 

1.1 Overview 
TESLA is a software tool designed to aid decision makers.  It has several purposes: 

1. To assist decision makers to assess and record not only evidence that supports or refutes 

a claim, but also any uncertainties that may exist, for example due to lack of knowledge. 

2. To provide a structure for breaking a complex decision down into manageable chunks. 

3. To provide a full audit trail of the information that was used to reach a decision. 

4. To provide decision makers with tools to analyse their decision, enabling effective 

targeting of funds and resources at areas that have the most bearing on the overall 

decision. 

The software is based on a form of decision theory called Evidence Support Logic (ESL), which 

is discussed in detail throughout this document.  Further details on the background behind ESL, 

the way it has been adapted for practical application in TESLA, and the way it is typically used to 

support decisions are provided in “Evidence Support Logic: A Guide for TESLA Users” 

(Quintessa, 2014).   

Importantly, TESLA does not take the place of the decision maker.  They are simply tools that are 

available to support the decision maker when making complex decisions, and to record the details 

of each decision so that it is robust and defendable. 

1.2 About this Document 
This document is the user guide for the software.  Although it provides an overview of the 

implemented decision support methodology, it does not define best practice, nor does it provide 

a detailed exposition of how to interpret results.  In addition, as it is intended that the software 

should be both intuitive and user-friendly, this document does not contain details of every menu 

or button available on the user interface.  When describing how to perform an action using the 

software, generally only one method will be mentioned.  However, there will often be multiple 

ways of achieving the same effect (e.g., right-clicking, using a keyboard shortcut etc.)  It is 

suggested that users should explore the software and find the method that best suits them. 

As far as possible, a consistent terminology has been used throughout this document.  Users may 

wish to refer to the glossary of terms in Appendix B for definitions of the key terms. 

1.3 An Introduction to Evidence Support 

Logic (ESL) 

1.3.1 Differences between ESL and MCDA/MADA 

You may have heard of multi-criteria decision analysis (MCDA, also known as multi-criteria 

decision making or multi-attribute decision analysis (MADA)), a common method applied to 

decisions that involve choosing one option from several different options.  For example, MCDA 

could be applied to choose a new car based on which would be most suited to your needs: a Ford 

Mondeo, a Peugeot 407, a Toyota Avensis etc.  Each option (i.e., car) is defined on the basis that 

it may plausibly meet the defined objectives (e.g., a family car that will seat 4) and scored based 

on how well it meets certain criteria, for example comfort, performance, fuel consumption etc. 

In contrast to MCDA, ESL is used to study a single hypothesis (e.g., “this car is comfortable”) in 

depth.  Whereas MCDA aims to answer the question “Which option is best?” ESL aims to answer 
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the question “How confident can I be that my hypothesis is true?”; the answers to the question if 

applied to different options or scenarios could then be used to evaluate those options and provide 

a comparison, but within a different logical framework and process to MCDA.  Since the answer 

to the question is quantitative, it is possible to compare the results of the same analysis as applied 

to different scenarios (or cars in this instance).  In TESLA, this is called a Portfolio Comparison.  

Portfolio comparisons are described in Section 12. 

A second difference between the two methods lies in the evaluation of criteria.  In MCDA, each 

option is usually scored or ranked based on how well it meets the criteria.  In ESL, two numbers 

are entered: the degree of confidence that the hypothesis is true given the evidence supporting it 

and the degree of confidence that the hypothesis is false given the evidence refuting it.  From 

these, a third value can be calculated that expresses either the degree of uncertainty arising from 

a lack of evidence and/or confidence in the evidence, or the degree of conflict in the available 

evidence/overconfidence in the evidence.  This is referred to as the residual uncertainty due to 

uncommitted confidence or over-committed confidence.  Residual uncertainty arising from lack of 

evidence could be due to missing research (e.g., did you actually try all the seats in the car?) or 

an inability to collect evidence (e.g., it wasn’t possible to test the effectiveness of the windscreen 

wipers because it wasn’t raining on the day of the test drive).  Note that the total uncertainty in the 

truth of a hypothesis reflects the balance of confidence for and against it based on evidence, and 

any residual uncertainty due to uncommitted confidence, which could potentially be resolved to 

either confidence for or against the hypothesis following additional research.  More broadly there 

are many kinds of uncertainty and reducing residual uncertainty due to uncommitted confidence 

or over-committed confidence alone does not necessarily guarantee clarity of outcome.  It may be 

necessary to acquire additional evidence, reconsider existing evidence or consider alternative 

lines of reasoning to shift the balance of confidence in favour of one outcome or another.  These 

concepts are described further in Section 5.2. 

Accounting for uncertainty in a decision, understanding how it affects the outcome, and planning 

how to reduce it are some of the most important aspects of ESL. 

1.4 Decision Tree Structure and Terminology 
A decision is typically informed by determining whether some hypothesis is reliable.  For example, 

consider the decision of whether to take an umbrella with you when you leave the house.  This is 

informed by the reliability or accuracy of judgements related to the hypothesis “It will rain today” 

(or equally “It will not rain today”) - if this hypothesis is judged very likely to prove true, an umbrella 

would be a good idea.  If it appears very likely to be false, there is probably no need for the 

umbrella.   

Complex decisions are often best solved by breaking the main hypothesis down into several 

simpler constituent hypotheses.  These can then be broken down further, until a point is reached 

where some information is known about the lowest level hypotheses.  Consider the problem of 

deciding whether to take an umbrella with you when you leave the house.  To determine the 

truthfulness of the hypothesis “It will rain today” you might do several things.  First, you would look 

outside to see if it is currently raining.  If it is, it will certainly be a good idea to take your umbrella!  

If it isn’t, you need to consider whether it might rain whilst you are out.  You might consider 

evidence sources such as the presence and nature of the clouds in the sky or look at a forecast 

given in a newspaper, on the television or radio or via the internet.  Local or national forecasts 

might provide different levels of confidence in the forecasts.  This simple example shows how 

information is gathered to answer simpler questions, the answers to which are combined to 

produce a solution to the overall question.  TESLA provides a framework for the propagation of 

this information, from the points of knowledge through to the solution of the original problem. 
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This framework is known as a Decision Tree, shown below in Figure 1.  Like any other kind of 

tree, it starts at the roots and grows outwards, branching as it does so, and ending at the leaves.  

Each point on the tree represents a hypothesis.  There are two special kinds of hypotheses; the 

Root Hypothesis, of which there can only be one, and the Leaf Hypothesis, of which there can be 

many. 

 

Figure 1: The Decision Tree structure. 

The Root Hypothesis, coloured yellow in the figure, is always positioned at the top left of the tree.  

It is the only hypothesis in the tree not to have a Parent – i.e., it does not originate from any other 

hypothesis.  The root hypothesis is the ultimate destination of all the information within the tree; it 

is here that the final assessment will be provided. 

The root hypothesis will have one or more Children.  Child hypotheses are simply hypotheses that 

have a parent, i.e., they originate from another hypothesis.  They may also be parent hypotheses 

themselves if they in turn have one or more child hypotheses of their own.  Thus, the tree branches 

down and to the right through a succession of hypotheses.  Hypotheses that share the same 

parent are called Siblings. 

Most hypotheses will have both a parent and one or more children (coloured orange in the figure).  

However, some have no children; these are the second special type of hypothesis, known as Leaf 

Hypotheses.  Leaf hypotheses are coloured green on the figure above.  A leaf hypothesis is 

always the final hypothesis on a Branch of the tree.  These are the points where information is 

input into the tree by the user; levels of confidence that the hypotheses are true and false based 

on the available evidence. 

The information is then propagated up the tree from the leaves to the root according to a chosen 

Propagation Method, which is a model for how confidence in child hypotheses is believed to 

combine to give confidence in their parent hypothesis.  The propagation methods employed by 

TESLA are contained in an appendix to this user guide, but it is not necessary to understand the 

mathematics to use the software.   

Root 
Hypothesis 

Hypothesis 

Leaf 
Hypothesis 

Hypothesis 
 

Leaf 
Hypothesis 

Leaf 
Hypothesis 
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2 Installing TESLA 

2.1 System Requirements 
TESLA 2.2 runs under 32-bit and 64-bit flavours of Windows 10 having Microsoft .NET 

Framework 4.6 or later installed.  It may run under earlier versions of Windows that have been 

kept up-to-date and have the necessary libraries, but the software has not been tested in such 

environments.  Any modern PC will meet the hardware requirements of the software. 

2.1.1 Microsoft .NET 

TESLA requires Microsoft .NET Framework 4.6 or later.  It is provided by default with Windows 10. 

2.2 Installation 
An installer for TESLA can be downloaded via the Quintessa website: 

https://www.quintessa.org/software/TESLA 

The software is packaged into a self-extracting installer that should be saved to a suitable place 

on the destination computer.  Once downloading has completed, double-click on the .msi file to 

launch the installer, which will lead you through the installation process.  From version 2.2, TESLA 

installs in per-user mode and so administrator privileges ought not be required.  

Once installed, TESLA can be launched via the shortcut on the desktop or the entry in the Start 

menu.  Until an activation code is acquired, TESLA will operate in restricted mode, as described 

below. 

2.3 Use of TESLA in Restricted Mode 
Unless an activation code is ordered from Quintessa, TESLA operates in restricted mode.  In this 

mode, several important functions are disabled.  For example, decision trees cannot be saved, 

and new trees cannot be constructed with more than 10 hypotheses. 

In restricted mode, TESLA may be freely used for the following: 

1. Evaluation of the software, prior to purchase. 

2. Viewing (but not altering the structure of) decision trees developed in an installation of 

TESLA operating in unrestricted mode. 

2.4 Unlocking Full Functionality 
To unlock the full functionality of TESLA, an activation code must be purchased from Quintessa.  

Please email 

tesla@quintessa.org 

for further details and a quote.  If you decide to purchase full functionality, you will be sent an 

activation code and instructions for applying it. 

2.4.1 Obtaining Your Unique Identifier 

When ordering an activation code, you will be asked for a unique identifier.  To obtain this, launch 

TESLA on the computer you wish to purchase full functionality for.  Select ‘Order Full 

Functionality…’ under the Help menu to display a window like the one shown in Figure 2 below. 

https://www.quintessa.org/software/TESLA
mailto:tesla@quintessa.org
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Figure 2: Obtaining a unique identifier needed to order full functionality. 

The identifier can be copied to the system clipboard using the Copy button and pasted (Ctrl-V) to 

an email or a plain text file for sending to Quintessa. 

Once licence terms have been agreed and payment has been received, an activation code will be 

emailed to you.  Click ‘Enter Activation Code…’ under the Help menu and paste the code into the 

box displayed (Figure 3). 

When a valid activation code is entered, complete functionality will be unlocked. 

  

Figure 3: Entering the activation code to unlock full functionality. 
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3 Building a Decision Tree 
The first step in decision-making using TESLA is to construct a hypothesis that represents your 

decision, as discussed in Section 1.4.  The next step is to construct a decision tree.  This is 

achieved by breaking down your main hypothesis into child-hypotheses until the lines of reasoning 

reach a level of detail for which there is supporting or refuting evidence available.  This section 

describes how to go about this process using the TESLA interface. 

If at any stage during the tree-building process you are unsure as to what information must be 

entered in a field, then a tooltip with guidance can often be produced by hovering over the 

associated field label with the mouse pointer within the software. 

3.1 Creating a New Tree 
To create a new tree from scratch, click ‘New Tree’ under the ‘File’ menu (or use the button on the 

toolbar).  A Decision Details form will be shown as depicted in Figure 4.  This can be retrieved at 

any point by selecting the menu option in the ‘Tree’ menu.  Here the user can enter their name 

and a title and description for the tree.  This form is also used to report the tree version number, 

its status and to access the change log, all of which will be discussed further later. 

Once the user and tree details have been completed, press OK to close the form and start editing 

the tree itself. 

 

Figure 4: The Decision Details form 

3.2 The Tree View Display 
The main view in TESLA is the Tree View display; this is where the decision tree is constructed, 

and tree parameters and confidence values are added by the user.  When you first start a new 

decision tree the display will look like Figure 5, with a single hypothesis appearing.  This is the 

root hypothesis (see Figure 1) and will always be located at the top left of the tree.   
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Figure 5: The Tree View display, showing a new decision. 

It is possible to have several trees open in the same instance of TESLA; each is displayed on its 

own tab, and navigation between them is achieved by clicking the tabs at the top of the Tree View 

display.  Each tab is labelled with a title that is supplied by the user when a new tree is created 

(Figure 4).  Provided the tree has already been saved to file, hovering over a tab with the mouse 

cursor will display the file path of the associated .tes file within a tooltip.  A ‘#’ symbol in front of 

the tree name indicates that it contains unsaved changes. 

3.2.1 Zooming 

The magnification of the Tree View can be altered in several ways: 

• by using the slider and buttons at the bottom right of the TESLA window, or 

• by using the zoom items in the View menu or the associated keyboard shortcuts 

(Ctrl+Plus or Ctrl+Minus), or 

• if a mouse with a scroll wheel is available, then the zoom level can be changed by 

pressing Ctrl while scrolling the mouse.  

3.3 Editing a Hypothesis Name and Summary 
The root hypothesis should be related to your decision, as discussed in Section 1.4 of the 

Introduction.  For example, if our decision was whether to take an umbrella with us when we leave 

the house today, a corresponding root hypothesis might be “It will rain today”. 

To edit the title of a hypothesis, double-click it to bring up the Hypothesis Properties dialog (Figure 

6).  Enter the hypothesis in the ‘Short Hypothesis’ field, and a more detailed version (if required) 

in the ‘Detailed Hypothesis’ field.  The ‘Explanation’ box can be used to include a further 

explanation of terms used in the other two fields, or to include extra information about the 

hypothesis. 
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Figure 6: Editing short and detailed hypothesis titles in the Hypothesis Properties dialog. 

Closing the Hypothesis Properties dialog, you will see that the root hypothesis has been updated 

with the new name.  It is also possible to display the hypothesis summaries on the Tree View 

display; simply select Show Hypothesis Summaries from the View menu. (This menu item can be 

toggled to turn summaries on and off.) 

 

Figure 7: The Tree View display, with hypothesis summaries shown. 

3.4 Adding Child Hypotheses 
As described in the introduction, decisions are often complex and can be simplified by breaking 

them down into lines of reasoning, until leaf-level hypotheses are defined with which there is 

associated evidence.  For example, our root hypothesis “It will rain today” could be broken down 

into the three child hypotheses “The weather forecast predicts rain”, “It is cloudy outside” and “It 

is already raining”.  Each of these is easier to establish the truth or falsehood of than the general 

statement “It will rain today”. 

To add a child hypothesis, right-click on the parent and select ‘New Child Hypothesis’ from the 

pop-up menu.  Repeat this process as many times as necessary. 

Each of these child hypotheses might be broken down further.  For example, the hypothesis “The 

weather forecast predicts rain” could be broken down into the child hypotheses “The national TV 

forecast predicts rain” and “The local newspaper forecast predicts rain”.  Hypotheses should be 

continually simplified in this manner until a point is reached where the final hypotheses (leaf 
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hypotheses) are simple enough that it is easy to judge whether the available evidence supports 

or refutes them.  An example tree with several hypotheses is shown in Figure 8. 

 

Figure 8: A simple example decision tree 

3.5 Hypothesis Numbering 
As shown in Figure 8, all hypotheses (except the root hypothesis) are automatically assigned 

numbers according to their position in the tree.  This makes it easy to identify hypotheses in a 

complex tree with many branches.  However, the numbers can be hidden by selecting ‘Hide 

Hypothesis Numbers’ from the ‘View’ menu.  The same menu item is also used to redisplay the 

hypothesis numbers once hidden. 

3.6 Expanding and Collapsing Hypotheses 
If a hypothesis has children (e.g., the root hypothesis, or hypothesis 1 in Figure 8) a small grey 

box is shown to the left of the hypothesis image.  Clicking on this box will show or hide that 

hypothesis’ children.   

It is also possible to collapse or expand all hypotheses at a given level.  This is achieved by right 

clicking a hypothesis at the desired level and choosing ‘Collapse/Expand Tree at Selection Level’ 

from the pop-up menu.  The ‘Expand All’ item in the main ‘View’ menu expands all collapsed 

hypotheses in the tree. 

3.7 Editing Trees 

3.7.1 Cutting, Copying, Pasting and Deleting Hypotheses 

The ‘Edit’ menu contains the usual editing controls Cut, Copy, and Paste.  These are also 

available via keyboard shortcuts or right clicking a hypothesis.  Hypotheses or groups of 

hypotheses can be cut or copied from a tree and pasted into the same or a different tree as a child 
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hypothesis.  They can also be pasted into a new tree as a root hypothesis.  Note that if a 

hypothesis has children, they are also copied, as are the child hypothesis’ children, and their 

children, and so on until a leaf hypothesis is reached.  In other words, the whole tree branch 

between the selected hypothesis and the leaf hypothesis is copied rather than the single 

hypothesis.  It is worth noting that TESLA contains its own ‘clipboard’ to hold a copied section of 

a tree.  This internal clipboard will be lost when the application is closed. 

The root hypothesis can never be deleted, as it is an essential part of the tree, but any other 

hypothesis may be freely deleted.  If a hypothesis has children and is deleted, the whole branch 

stemming from the selected hypothesis will be removed.  A second delete option is found under 

the ‘Edit’ menu, which is ‘Delete Child Hypotheses’.  This deletes all the currently selected 

hypothesis’ children (and branches stemming from them). 

3.7.2 Reordering Sibling Hypotheses 

Sibling hypotheses can be reordered by first by selecting a hypothesis and then shifting it up or 

down relative to its siblings.  This is achieved using the ‘Move Up’ and ‘Move Down’ options from 

the hypothesis’ right-click context menu or the associated keyboard shortcuts (Ctrl+Up and 

Ctrl+Down).  Since the hypothesis numbering indicates the positions of the hypotheses in the tree, 

hypothesis numbers are automatically re-calculated. 

3.7.3 Altering the Decision Details 

The Decision Details form (Figure 4) appears whenever a new tree is started, or an old tree is 

opened from file.  It can also be viewed, and the information edited, at any point by selecting 

‘Decision Details’ from the ‘Tree’ menu. 



 User Guide for TESLA 2.2, v1.1 

 15 

4 Tree Parameterisation 
Before evidence is assessed and confidence values added to the tree, it needs to be 

parameterised.  This includes specifying the relative importance of each sibling hypothesis, the 

degree of commonality between sibling hypotheses (that is the extent to which they represent the 

same concepts and reasoning, or require the same information to judge them), and whether an 

outcome of a sibling hypothesis could individually be a “show-stopper”.   

4.1 Sufficiency 
‘Sufficiency for’ and ‘sufficiency against’ parameters must, in general, be specified for each child 

hypothesis in the tree.  (Note that the use of logical operators, described in Sections 4.3.2 and 

4.3.3, may make certain sufficiency values redundant.) They specify the degree to which proof or 

disproof of a hypothesis is sufficient to prove or disprove its parent hypothesis on a scale where 

0 means totally insufficient and 1 means totally sufficient.  To determine a sufficiency for or against 

parameter for a given hypothesis it can be helpful to ask the question: “In the absence of any other 

knowledge; if the hypothesis were known to be true or false, then how confident would you be that 

the parent hypothesis is true or false?”  

Sufficiency values influence how confidence values are propagated up the tree.  Greater 

sufficiencies will result in confidence values being propagated more strongly up the tree hierarchy.  

To input sufficiency values for a hypothesis, double-click it to bring up the Hypothesis Properties 

dialog and select the ‘Parent Hypothesis’ tab.  Use the two sliders to input sufficiency for and 

against values (Figure 9). 

 

Figure 9: Editing sufficiency values. 

Sometimes the sufficiency for and sufficiency against values will be the same.  However, perhaps 

more often and as in our example, they may take different values.  Consider the hypothesis “It is 

already raining”.  Clearly, if this is true then the root hypothesis “It will rain today” must also be 

true.  This suggests that the sufficiency of confidence for should be 1.  However, if this hypothesis 

is false (i.e., it is not currently raining) this does not actually tell us much about whether it will rain 

later or not.  Thus, the sufficiency of confidence against should be much lower - here it has been 

set to 0.2.  This low sufficiency value means this hypothesis has a low weighting when considering 

confidence against. 
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The sufficiency values of a hypothesis are depicted to the left of the hypothesis image, as shown 

in Figure 10.  The sufficiency of confidence for is shown at the bottom, in green, and the sufficiency 

of confidence against is shown at the top, in red1. 

 

Figure 10: The sufficiency values are shown to the left of the hypothesis image. 

4.2 Dependency 
With each set of sibling hypotheses there is a chance that some of the confidence they contribute 

to the parent hypothesis may arise from common judgements on evidence i.e., overlap in key 

elements of the evidence base, and the dependency value of the hypotheses reflects this.  The 

value must lie between 0 (no overlap) and 1 (full overlap).  This parameter is used to avoid ‘double-

counting’ of evidence when evaluating confidence in a parent. 

Unless the user specifies otherwise, zero dependency is assumed.  

To edit the dependency between a set of sibling hypotheses, double-click their parent to bring up 

the Hypothesis Properties dialog and click the ‘Child Hypotheses’ tab.  Use the slider at the bottom 

right to change the dependency value. 

 

Figure 11: Editing the dependency between a set of sibling hypotheses. 

In our example, there is likely to be some dependency between the two child hypotheses “The 

national TV forecast predicts rain” and “The local newspaper forecast predicts rain”, since both 

will obtain their information from the same source (e.g., national meteorological agency forecasts, 

in turn representing expert judgements on data and computational model outcomes).  Each 

forecast may interpret this data differently though, with the local forecast being at a higher spatial 

resolution than the national one. 

 

1 Note that prior to version 2.2, sufficiency for was displayed at the top and sufficiency against was 

displayed at the bottom. 
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The dependency value assigned to the children of a hypothesis is shown underneath the 

hypothesis image, as depicted in Figure 12. 

 

Figure 12: The dependency between the children of a hypothesis is shown underneath the 
hypothesis image. 

4.2.1 Alternative Dependencies 

If there are more than two siblings, the level of commonality between each individual hypothesis 

and its siblings may differ.  In this case, a separate dependency value can be specified for each 

possible grouping of sibling hypotheses.  These are referred to as alternative dependencies.  To 

specify alternative dependencies, click the button ‘Specify Alternative Dependencies...’ on the 

Child Hypotheses tab (shown in Figure 11).  For the root hypothesis of our example the dialog in 

Figure 13 will be shown. 

 

Figure 13: Specifying alternative dependencies between groups of siblings. 

On the left is a depiction of all the sibling hypotheses, each one of which is assigned a number in 

brackets.  On the right is a list of all possible groupings of the siblings.  A separate dependency 

value can be specified for each group by selecting it from the list and using the slider to enter a 

value. 

Note that the dependency of a group must be less than or equal to the dependency of any 

subgroup contained within it; for example, the dependency between all the siblings 1, 2 and 3 

cannot exceed the dependencies between 1 and 2, 1 and 3 or 2 and 3.  

If the children of a hypothesis have alternative dependencies specified, an asterisk will be shown 

next to the value of the dependency underneath the hypothesis image. 

4.3 Operators 
Unless the user specifies otherwise, TESLA combines confidence from sibling hypotheses using 

a model that results in confidence values for and against their parent being greater than or equal 

to the confidence values that would be provided by any child individually.  These confidence 
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values are related to the sufficiency of the child for (and against) proving the parent, and the actual 

confidence values identified for and against the child. (See Appendix A.) 

Sometimes it is useful to be able to apply other criteria for the propagation of confidence values.  

These criteria could arise through logical arguments or could be required by those people or 

organisations who define the context for the judgement, such as regulatory bodies.  TESLA 

provides three types of heuristic operators: 

• Necessity heuristics can be used to identify individual hypotheses for which insufficient 

confidence implies that confidence in their siblings should be disregarded. 

• ALLs can be used to ensure that a confidence value propagated to a parent is only as 

strong as that arising from the child hypothesis in which there is the weakest confidence 

(and can be applied to ‘confidence for’ and/or ‘confidence against’). 

• ANYs can be used to ensure that a confidence value propagated to a parent is as strong 

(more precisely, only as strong) as that arising from the child hypothesis in which there is 

strongest confidence (and can again be applied to ‘confidence for’ and/or ‘confidence 

against’). 

These operators are described in more detail in the following sections. 

4.3.1 Necessity Heuristic 

Prior to TESLA 2.2 there was only one necessity heuristic, which will henceforth be referred to as 

the Asymmetric Necessity Heuristic.  TESLA 2.2 defines a new Symmetric Necessity Heuristic, 

which is set as the default for new trees.  The option can be changed via the Tree > Tree Options… 

menu item.  See Figure 14. 

 

Figure 14: Changing the type of necessity heuristic via the Tree Options dialog 

Symmetric  

The symmetric necessity heuristic allows hypotheses to be identified as necessarily true such 

that, irrespective of their siblings, confidence that they are true is required to have confidence in 

their parent being true.  Alternatively, it can allow some hypotheses to be identified as necessarily 

false, such that irrespective of their siblings, confidence that they are false is required to have 

confidence that their parent is false.  For example, a site for a new supermarket must have 

planning permission.  If there is sufficient confidence that this will not be achieved based on 

available evidence, then the site may not be chosen, even if it was perfect in every other sense.  
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Therefore, it may be appropriate to mark a child hypothesis identifying that “The supermarket will 

acquire planning permission” as necessarily true.  

The confidence values of necessary hypotheses are subject to a threshold test.  If a necessarily 

true hypothesis fails by exceeding a threshold associated with confidence against, then the 

confidence value against the parent will be set so that it is at least as large as that of the necessary 

hypothesis.  If a necessarily true hypothesis fails a test by not meeting the confidence for 

threshold, then the confidence value on the parent will be set so that it is no greater than that of 

the necessary hypothesis.   

For each of these tests, if confidence for / against does not cause failure compared to the 

threshold, then normal propagation rules for the confidence for / against apply. 

For a hypothesis that is necessarily true for its parent is to be true, confidence for must meet or 

exceed ½ to pass the confidence for necessity test and confidence against must not exceed ½ to 

pass the confidence against test.  For a hypothesis that is necessarily false for its parent to be 

false, confidence against must meet or exceed ½ to pass the confidence against necessity test 

and confidence for must not exceed ½ to pass the confidence for necessity test. 

To mark a hypothesis as being necessarily true or false, double click the hypothesis to open the 

hypothesis properties dialog and select the Parent Hypothesis tab.  (See Figure 9.)  Mark the 

hypothesis as Necessary and choose whether it is necessarily true or false.  Note that all 

necessary sibling hypotheses must be of the same type; necessarily true or necessarily false.  It 

is not possible to combine both types.  Hypotheses that are necessarily true or false are indicated 

on the Tree View display by a pale green or red background, respectively.  See Figure 15 for an 

example. 

 

Figure 15: Necessarily true hypotheses are indicated by a pale green background. 

Asymmetric 

The asymmetric necessity heuristic differs from the symmetric heuristic in the following ways: 

• The asymmetric heuristic only treats the case where either one of confidence for or 

confidence against a hypothesis fails to meet a criterion. (The symmetric algorithm 

described above applies tests on both confidence for and against simultaneously, and 

hence is symmetric with respect to confidence for and against.) 

• The asymmetric heuristic only treats the case where the necessary hypothesis must be 

true for the parent to be true.  It does not treat the case where the necessary hypothesis 

must be false for the parent to be false. 

• The failure criterion (whether to test confidence for or confidence against) is defined 

globally as a tree option, rather than on a hypothesis-by-hypothesis basis. 

If a hypothesis marked as a necessity fails the predefined confidence test, then the confidence 

values for and against propagated to its parent will be at least as much as the confidence assigned 
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to the failing hypothesis, irrespective of the sufficiency or dependency values specified (“at least 

as much” because siblings of the failed hypothesis may contribute extra confidence).2 

To use the asymmetric necessity heuristic, it must be enabled via the Tree Options.  See Figure 

14.  Then, to mark a hypothesis as being a necessity, double-click it to bring up the Hypothesis 

Properties dialog and select the ‘Parent Hypothesis’ tab.  (See Figure 9.)  Check the box marked 

‘Necessary’ at the bottom of the dialog.  Hypotheses that are a necessity using the asymmetric 

algorithm are indicated on the Tree View display by a grey background to the hypothesis image, 

as shown in Figure 16. 

 

Figure 16: Necessity is indicated by a grey background. 

Hypothesis Failure 

Two different confidence test criteria can be used to specify whether a hypothesis has failed when 

using the asymmetric heuristic: if the confidence against is greater than 0.5 (the default method); 

or if the confidence for is less than 0.5.  The criterion for determining hypothesis failure applies to 

the entire tree and can be set in the ‘Necessity Heuristic’ tab of the Options dialog.  See Figure 

14.  This choice only affects hypotheses that have been marked as a necessity. 

4.3.2 ALL Child Hypotheses Required. (The “Weakest Link” 

Heuristic.) 

The ALL heuristic operator is used to enforce a rule that a confidence value associated with the 

parent is the same as the weakest of its children.  It can be applied to confidence for or confidence 

against (or both) and it works by propagating the minimum of the child confidence values.  

Therefore, it can be used to consider confidence from the child hypothesis with the weakest 

confidence for or the child hypothesis with the weakest confidence against 

The operator has the properties that a complete absence of confidence in any child hypothesis 

implies a complete absence of confidence in the parent.  Furthermore, complete confidence for 

(or against) a parent can only be achieved with complete confidence for (or against) all children. 

With the ALL operator, confidence values for child hypotheses do not combine to give greater or 

lesser confidence values for the parent.  The child hypotheses should be considered alternatives, 

of which only the weakest line of reasoning is considered.   

This form of logic is typically used when various lines of reasoning are critical to success of a 

parent, but it is not possible to determine the sufficiency of each to prove the parent (see below) 

because it is not meaningful to consider their impact on the parent independently.  For example, 

regulatory guidance might require that certain lines of reasoning have equal prominence in a 

decision, so that an independent assessment of their impact is not possible. 

 

2 Note this means an increase in the confidence against a necessary hypothesis can sometimes 

lead to an increase in the confidence for the parent.  This happens if the confidence propagated 

without modification by sufficiency is greater than that which would be normally propagated by the 

standard propagation method.  This is counter-intuitive; the symmetric algorithm does not suffer 

from this anomaly. 
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In our example, the fact that the sky is covered in cloud is not sufficient on its own to determine 

whether it is going to rain - we also need to ascertain whether the clouds are rain-bearing or not.  

Similarly, if we spot a rain-bearing cloud in the distance, but the rest of the sky is blue, it does not 

necessarily mean that it will rain.  If we had no information about either one of these factors, we 

would be completely uncertain about whether it looks like rain.   

To override the propagation algorithm and specify that all child hypotheses are required for 

confidence in the parent, double-click the parent hypothesis to bring up the Hypothesis Properties 

dialog.  Click the ‘Child Hypotheses’ tab and chose the appropriate radio button (Figure 11) - the 

propagation method can be overridden for the confidence for and/or the confidence against.   

If the propagation algorithm has been overridden in this fashion, the sufficiency value in the 

hypothesis image is replaced by “ALL” in the Tree View display, as shown in Figure 17. 

 

Figure 17: If all child hypotheses are necessary, the sufficiency values of the siblings are 
replaced by “ALL” in the Tree View display. 

 

4.3.3 ANY Child Hypothesis Sufficient. (The “Strongest Link” 
heuristic.) 

The ANY heuristic operator is used to enforce a rule that a confidence value associated with the 

parent is the same as that of the strongest of its children.  It can be applied to confidence for or 

confidence against (or both) and it works by propagating the maximum of the child confidence 

values.  Therefore, it can be used to consider confidence values from the child hypothesis with 

the strongest confidence value for or the child hypothesis with the strongest confidence value 

against. 

The operator has the properties that complete confidence for (or against) any child hypothesis 

gives complete confidence for (or against) the parent.  Furthermore, a complete absence of 

confidence for (or against) a parent can only be achieved with a complete absence of confidence 

for (or against) all children. 

As with the ALL operator, the ANY operator has the property that confidence values associated 

with child hypotheses do not combine to give greater or lesser confidence in the parent.  For the 

ANY heuristic operator, the child hypotheses should be considered alternatives of which only the 

strongest line of reasoning is considered. 

As for ALL, the ANY operator is often used where specific considerations, such as regulatory 

guidelines, govern the overall confidence that can be attributed to multiple lines of reasoning. 

In our example, if we look outside through the window, we know it is raining if either we spot some 

people sheltering under umbrellas or we can see the raindrops splashing onto the ground.  Both 

hypotheses are sufficient on their own to have confidence in the statement that it is already raining.  

However, the overall judgement of the truthfulness of the parent uses these different kinds of 

evidence independently; you would not be more likely to take an umbrella if you observed 
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raindrops splashing on the ground AND observed people sheltering under umbrellas, than if you 

saw ONLY raindrops splashing OR people sheltering (but no raindrops). 

To override the propagation algorithm and specify that any child hypothesis is sufficient to provide 

confidence for (or against) the parent, and that the confidence for (or against) across the group 

does not combine when providing confidence to the parent, double-click the parent hypothesis to 

bring up the Hypothesis Properties dialog.  Click the ‘Child Hypotheses’ tab and choose the 

appropriate radio button (Figure 11) - the propagation method can be overridden for the 

confidence for and/or the confidence against.   

If the propagation algorithm has been overridden in this fashion, the sufficiency value in the 

hypothesis image is replaced by “ANY” in the Tree View display, as shown in Figure 18. 

 

Figure 18: If any child hypothesis is sufficient on its own, the sufficiency values are replaced by 
“ANY” in the Tree View display. 

 

4.4 Recording Tree Parameterisation Choices 
TESLA aims to provide a capability to record a complete audit trail for the decision.  This includes 

not only the sources of the evidence values that are entered, but also the rationale behind the tree 

structure.  The box labelled ‘Rationale’ on the ‘Notes’ tab of the Hypothesis Properties dialog is 

provided for this purpose (Figure 19). 

 

Figure 19: Entering a rationale for the tree parameterisation. 
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5 Entering Confidence Values 
Once the tree structure is complete, it is time to start collecting sources of evidence and entering 

confidence values at the leaf hypotheses. 

5.1 About Confidence Values 
Confidence values can only be entered directly at a leaf hypothesis (a hypothesis with no 

children).  Confidence values for all other hypotheses in the tree will be automatically calculated 

using the propagation model, described in Appendix A. 

Two confidence values must be entered for each hypothesis; confidence that the hypothesis is 

true given the available supporting evidence (“confidence for”) and confidence that the hypothesis 

is false given the available refuting evidence (“confidence against”).  These are quantified by 

selecting a number between 0 (no confidence; the evidence says nothing about the truth or 

falsehood of the hypothesis) and 1 (total confidence that the evidence supports or refutes the 

hypothesis). 

From these confidence values an additional quantity can be calculated which is referred to as the 

residual uncertainty due to uncommitted or over-committed confidence, and which can vary from 

-1 to 1. 

(Confidence For) + (Residual Uncertainty due to Uncommitted or Over-committed Confidence) + 

(Confidence Against) = 1 

This residual uncertainty reflects the degree of uncertainty in the confidence assessment due to 

a lack of evidence or lack of confidence in the evidence when positive and the degree of conflict 

due to overconfidence or inconsistent evidence when negative. 

5.2 Assessing and Improving Confidence 
In an ideal world, the evidence in support of or against each hypothesis would be such that it was 

conclusive, making it easier for decision makers to justify their decisions.  This is indicated in 

TESLA by strong confidence for or against the hypothesis being true, and zero residual 

uncertainty.  See Figure 20, cases a) and b). 

However, the reality is often much less clear-cut than that.  In the extreme case, there may simply 

be no evidence on which to make any judgement, so that the confidence for and against are both 

zero.  In this case, the residual uncertainty due to uncommitted confidence is unity.  See Figure 

20, case c). 

The residual uncertainty due to uncommitted confidence is represented by the amount of white 

space in the flag and is a measure of uncertainty related to a lack of evidence or a lack of 

confidence in the available evidence.  This could result from a basic lack of information, 

inaccuracies in experimental data etc.  Confidence can generally be improved by obtaining more 

evidence and/or improving the quality of evidence.  In the extreme case c), nothing is known about 

the truth or falsehood of the hypothesis, but there is potential to improve matters by seeking 

evidence. 

After obtaining evidence and improving confidence, it may still be the case that the evidence is 

inconclusive.  See Figure 20, case d).  When, as in this example, there is no white space at all 

(zero uncommitted confidence), the flag can be interpreted as indicating the odds that the 

hypothesis is true or false given the available evidence.  In some cases, it may be possible to 

undertake new investigations or obtain new evidence that will shift the balance of confidence 

towards an assessment that the hypothesis is true or false.  Undertaking such actions to obtain 
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further evidence can aid decision-making.  Alternatively, it may be possible to recast the 

hypothesis or break it down by adding child hypotheses with narrow focus, resulting in a better 

alignment with the available evidence, and so permitting a more conclusive assessment. 

Sometimes there may be a sufficient conflict in the confidence levels that green and red fields in 

the flag overlap, producing a yellow region, which is referred to as residual uncertainty due to 

over-committed confidence (See Figure 20, case e.)  This may arise due to poor or inaccurate 

evidence, or overconfidence in some or all the evidence, or conflicting objectives inherent in the 

hypothesis.  In this case, action will typically be taken to identify and address the conflict, 

depending upon how important it is to the overall outcome. 

a) 
 

Complete confidence that the hypothesis is true 

b) 
 

Complete confidence that the hypothesis is false 

c) 
 

No confidence, implying that there is no evidence on which to 

make any judgement for or against the hypothesis.  The 

residual uncertainty is unity. 

d) 
 

Even though there is considerable evidence, it is not 

conclusive.  It is equally likely that the hypothesis is true or 

false, based on the available evidence.  

e) 
 

The evidence is conflicting and judgements on the evidence 

are overconfident.  Efforts could be undertaken to identify and 

eliminate the cause of the conflict.  The conflict could arise from 

over-confidence in the available evidence, or from poor quality 

or incorrect evidence, for example. 

Figure 20: Examples of flags indicating different confidence levels. 

5.3 Inputting Confidence Values 
To input confidence for and against values, double-click a leaf hypothesis to bring up the 

Hypothesis Properties dialog then select the ‘Evidence’ tab.  Use the sliders to enter values 

between 0 and 1, as shown in Figure 21.  As you move the sliders the green and red bars in the 

graphic will increase or decrease in size.  The green portion represents the confidence for and 

the red portion the confidence against.  The white section is the residual uncertainty due to 

evidence being insufficient to assign confidence one way or the other.  Should the confidence 

values overlap (i.e., sum to more than 1), the overlap will be coloured yellow indicating conflict. 

In our example, for the hypothesis “The clouds are rain-bearing” we have assigned a confidence 

for of 0.7, because about 70% of the clouds look like they contain rain; and we have assigned a 

confidence against of 0.1, because about 10% of the clouds look like they do not.  The remaining 

0.2 is then the residual uncertainty arising from a lack of evidence or lack of confidence in the 

evidence, which could occur not only because we are not experts at identifying cloud types but 

also, for example, because some of the sky is obscured by buildings and trees around us. 
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Figure 21: Entering confidence values at a leaf hypothesis. 

In the Tree View display, the confidence values assigned to a hypothesis are displayed graphically 

in the hypothesis image, again using a horizontal green bar to show the proportion of confidence 

for, and a horizontal red bar to show the proportion of confidence against (Figure 22).  If the option 

to show confidence flow lines is selected (see Section 6.3), as is the case in Figure 22, the lines 

joining hypotheses are coloured red or green to indicate the propagation of confidence through 

the tree.  The widths of these red and green lines are proportional to the degree of confidence.  

The section between is coloured white to indicate uncommitted confidence, or coloured yellow to 

indicate overlap in the case of conflict (over-committed confidence).  Due to its appearance when 

confidence for and against are assigned and there is still uncommitted confidence, this image is 

sometimes referred to as an ‘Italian flag’. 



 User Guide for TESLA 2.2, v1.1 

 26 

  
Figure 22: The Tree View display with confidence values shown as “Italian flags” for each 

hypothesis. 

5.3.1 Linguistic Mappings 

Defining Mappings 

Sometimes, particularly when working with a group of experts in a workshop setting, it is helpful 

to use linguistic terms rather than numbers to indicate the confidence in the evidence that supports 

or refutes a hypothesis.  TESLA provides a mechanism for inputting confidence values 

linguistically. 

First you should decide on a set of terms to represent the degrees of confidence in the evidence 

supporting or refuting a hypothesis.  The default set of terms in TESLA are “Very good”, “Good”, 

“Average”, “Poor”, “Very poor” and “None”.  You should then assign numerical confidence values 

to each of these, ranging from 0 to 1.  The default mappings used in TESLA are shown in Table 

1.  The set of experts from whom you are eliciting confidence values should then be encouraged 

to use the linguistic terms, rather than numerical values, when describing their level of confidence 

in the evidence. 

Table 1: The default linguistic mappings employed by TESLA. 

Linguistic Term Mapped Confidence Value 

Very good 0.9 

Good 0.7 

Average 0.5 

Poor 0.3 

Very poor 0.1 
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Linguistic Term Mapped Confidence Value 

None 0 

 

To set up linguistic mappings in TESLA, double-click a leaf hypothesis to bring up the Hypothesis 

Properties dialog.  Click the ‘Linguistic Mappings’ tab and select the ‘Linguistic Mappings’ radio 

button on the left (Figure 23). 

   

Figure 23: Specifying linguistic mappings to use for inputting confidence values. 

The default mappings are shown on the right.  These can be edited by selecting a term from the 

list then using the controls on the right to change the linguistic term and the mapping value.  Press 

‘Update’ when finished to commit any changes. 

If desired, different linguistic mappings can be applied to confidence for or confidence against, 

using the check boxes above the slider control.  In addition, each leaf hypothesis can in principle 

be assigned its own set of linguistic mappings.  However, it is more likely that the same set will be 

used across all leaf hypotheses.  If that is the case, check the box ‘Use this method for all 

hypotheses in the tree’ on the left to apply the linguistic mappings entered here to all other leaf 

hypotheses.  

It is important to note that if the input mode is changed to linguistic after confidence values have 

been entered using the standard method with sliders (or a linguistic scheme is edited after 

confidence values have been entered), the existing confidence values will be altered by TESLA 

so that they are consistent with the new scheme.  So, for example, if a value of 0.95 had been 

entered and the default linguistic mapping scheme was then adopted, this value would be 

changed to 0.9 (corresponding to “Very Good”) since it is the nearest compliant value to the 

original.  Changing back to numerical confidence value input will not retrieve the original value of 

0.95 so care must be taken when using this option. 

Entering Confidence Values 

Once the linguistic mappings have been set, click the ‘Evidence’ tab to start inputting confidence 

values.  You will notice that the confidence sliders have been replaced by drop-down lists 

containing the linguistic terms defined on the ‘Linguistic Mappings’ tab (Figure 24).  To input 

confidence values simply select the relevant term from the drop-down boxes.   
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Figure 24: Inputting confidence using linguistic terms. 

5.3.2 Advanced Controls 

When assessing the level of confidence that can be had in the truth or falsehood of a hypothesis 

given the available evidence for or against, there may be several factors influencing the 

judgement, such as: 

• the quality of the evidence, 

• the quantity of evidence or evidence coverage; and 

• the face value of the evidence, i.e., of the evidence that is available, whether it supports 

or refutes the hypothesis. 

For example, a single piece of supporting experimental evidence may, if taken at face value, 

indicate that a hypothesis is true.  However, there may be doubts over technique or its accuracy, 

lowering confidence that the hypothesis is true.  On the other hand, several independent research 

groups may have independently verified the experiment – and this may act to increase confidence 

in the hypothesis being true.  In such situations it can sometimes be difficult to decide on an 

appropriate confidence value.  The advanced controls on the ‘Evidence’ tab of the Hypothesis 

Properties dialog can help to break down the assessment of confidence into component parts 

(quality, coverage and face value), thus making the judgements about the roles of the component 

parts more transparent.  

The advanced controls are disabled by default.  To enable them, select the ‘Enable’ radio button, 

as shown in Figure 25.  To use the advanced controls, the user will typically independently 

evaluate the quality¸ coverage and face value of the evidence in terms of provision of confidence 

in the parent.  Sliders are available to input the relevant values for each.  The final confidence 

values, indicated in the flag, are calculated as 

(confidence for/against) = (face value of evidence for/against) * (quality for/against) * (evidence 

coverage) 
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Figure 25: The advanced slider controls can be used to assess the impact of evidence quality 
and coverage on the judgement of confidence values. 

5.4 Recording Reasons for Selecting Confidence 

Values 
To provide a full audit trail of the decision, reasons for selecting confidence values should be 

recorded within TESLA.  To input this information, click the ‘Show Audit Trail’ button on the 

‘Evidence’ tab of the Hypothesis Properties dialog.  The audit trail pane will appear on the left 

(Figure 26). 

   

Figure 26: Clicking “Show Audit Trail” on the “Evidence” tab will open the confidence details 
pane on the left of the dialog.  Here reasons for selecting confidence values can be entered. 

There are two sections of the ‘Reasons’ tab in the evidence details pane: One for entering reasons 

for choosing the confidence for value, and one for entering reasons for choosing the confidence 

against value.  Both work in the same way.  To add a new reason, click ‘Add...’ underneath the 

relevant section.  In the dialog that appears enter a short title for the reason and, if required, a 

longer description, as shown in Figure 27.  You should also enter a name against the reason (this 

may be the name of the person editing the tree or, in a group workshop situation, the name of the 

expert who specifies the reason). 
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When the reason is committed by pressing OK, its title will be shown in the relevant section of the 

audit trail pane.  To view reason descriptions directly from the audit trail pane, simply hover the 

mouse over the reason title and the description will appear in a tooltip.  To edit an existing reason, 

select it and click ‘Edit’. 

Note that the reason title text box uses text completion to allow users to quickly input reasons 

(which may be applicable to multiple hypotheses in the tree).  Use the mouse, arrow keys or tab 

key to select the relevant reason from the list of possibilities - or keep typing to enter a new reason.  

If an existing reason is chosen, the description box will be filled in automatically. 

    

Figure 27: Adding a reason for selecting confidence values. 

5.4.1 Reference Files 

Often there will be files that back up confidence values.  For example, a spreadsheet which 

contains the output from a numerical simulation or a report describing experimental data.  TESLA 

allows the decision maker to link such files directly to the tree. 

To add a reference file to a hypothesis, double-click the hypothesis to bring up the Hypothesis 

Properties dialog and select the ‘Reference Files’ tab.  A list of all reference files currently linked 

to the hypothesis will be displayed (Figure 28); click ‘Import’ to add another.  Select an existing 

report from the tree library or add a new one from the library on the local computer. (See Section 

8 for details.) 
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Figure 28: Adding reference files to a hypothesis. 

Once a reference file has been linked to a hypothesis, it can be viewed by selecting it from the list 

of reference files and clicking ‘Open’.  This will launch the default application for the file type (e.g., 

Microsoft Word for .doc files or Adobe Reader for .pdf files) with the selected file opened for 

inspection. 

Hypotheses that have linked reference files are indicated in the Tree View display by a paperclip 

icon next to the hypothesis image, as shown in Figure 29. 

   

Figure 29: A paperclip icon indicates that a hypothesis has linked reference files. 

5.4.2 Links 

Supporting documentation for confidence values may often originate from a website.  The ‘Links’ 

tab on the Hypothesis Properties dialog (Figure 30) allows the user to link website URLs to a 

hypothesis.  Simply enter the website address in the ‘Link’ box and press ‘Add’.  Once a website 

has been added in this manner, it can be double-clicked to launch the default web browser and 

load the website. 

The Links tab can also be used to link to a local file, or a file located on a network share, in which 

case double-clicking the link will open the file in the default application.  Linking to files should 

only be chosen in preference to using the ‘Reference Files’ tab if the file that is being linked to will 

be available to everyone who might want to work on or view the decision tree, using the same 

path. 
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Figure 30: The Links tab, which allows the user to link website URLs to a hypothesis. 

5.5 Recording Outstanding Actions 
Once confidence values have been entered against a hypothesis, it can also be useful for decision 

makers to consider classes of actions that could be taken to strengthen what can be said about 

the truth or falsehood of the hypothesis. 

Improvements can be made by reducing the magnitude of the residual uncertainty due to 

uncommitted confidence or over-committed confidence.  This can be achieved by obtaining further 

evidence to address uncertainty due to lack of evidence or by addressing conflict of evidence.  

For example, to improve confidence in our judgement for the “The clouds are rain-bearing” we 

could get a book from the library about cloud forms or gather a group of independent 

meteorological experts to provide their judgements too. 

A similar approach for improving conclusiveness is to make changes or obtain further evidence 

or undertake new studies in a manner that is designed to shift the balance of confidence towards 

full support for the hypothesis being true or false.  This might result in a reassessment of 

confidence that reduces it in one direction (e.g., towards false) while increasing it in the other 

(towards true).  For example, if a hypothesis is related to the performance characteristics of an 

underground gas storage system, then we may be able to improve conclusiveness of a hypothesis 

related to its performance by adopting different engineering practices that are known to provide a 

better well seal.  This approach may also result in a reduction of residual uncertainty. 

Some evidence gathering actions will affect or improve both to some degree.  TESLA provides a 

mechanism whereby users inputting confidence values can list actions that could be undertaken 

to strengthen the conclusiveness of the hypothesis. 

To enter such actions, double-click the relevant leaf hypothesis and select the ‘Evidence’ tab from 

the Hypothesis Properties dialog.  Click ‘Show Audit Trail’ to show the audit trail pane on the left 

(if not already visible).  Within the pane itself, click the ‘Actions’ tab.  This tab is split into two 

sections; one for entering actions to reduce residual uncertainty and one for entering actions to 

improve conclusiveness.  (See Figure 31.)  These sections behave similarly to the sections on the 

‘Reasons’ tab (see Section 5.4 for details) and actions are entered in the same manner. 
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Figure 31: Clicking ‘Show Audit Trail’ on the ‘Evidence’ tab will open the audit trail pane on the 
left of the dialog.  Here actions for improving confidence and conclusiveness can be entered. 
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6 Analysing the Decision 
Once a tree has been parameterised and populated with confidence values, it can be used to 

inform decisions and to identify areas where efforts could be focussed to improve the 

conclusiveness of the root hypothesis.  TESLA includes several graphical tools that can be used 

for such purposes: 

• Uniform Confidence plots (Section 6.1) can be used to check that the parameterisation of 

the tree is plausible and that it does not preclude a positive or negative outcome. 

• Decision makers often are concerned by the question “How confident can we be that the 

root hypothesis is true or false given the available evidence?” If the confidence values 

propagated to the root hypothesis, as shown in the Tree Plot, are sufficiently conclusive 

then it may be that no further action needs to be taken.  (See Section 6.2.)  However, the 

user may want to analyse the sensitivity of the outcome to changes in confidence in the 

leaf hypotheses. (See Section 6.5.) 

• Confidence Flow Lines (Section 6.3) can be added to Tree Plots to visualise how 

confidence propagates from the leaf hypotheses to the root hypothesis.  The lines can 

help identify which leaf hypotheses (and ultimately, evidence sources) contribute to the 

root hypothesis outcome.  They can also be used to check the influence of logic on the 

propagation of confidence through the tree. 

• If the root hypothesis is not conclusive then the decision maker will typically wish to 

identify why not.  There may be areas where evidence is lacking or where it is in conflict 

leading to ambiguity.  The Ratio Plot (Section 6.4) helps decision makers to identify 

hypotheses on which to focus effort to improve the conclusiveness of the root hypothesis. 

• Tornado Plots (Section 6.5) help answer the question “Changes to confidence in which 

hypotheses will have the greatest impact on confidence in the root hypothesis?” This can 

help the decision maker to decide which hypotheses to focus effort on to improve the 

conclusiveness of the root hypothesis in the most effective manner. 

6.1 Uniform Confidence Plots 
It is important to test the tree structure during the decision-making process to ensure that the 

values chosen for sufficiency, dependency etc. lead to expected results.  For this purpose, a tool 

to produce Uniform Confidence plots is provided.  This tool allows the user to temporarily assign 

the same confidence value to all hypotheses at a chosen level in the tree (which are often all the 

leaf hypotheses), thus determining if confidence is propagated through the tree as intended.  The 

most useful confidence values to apply to the leaf hypotheses are confidences for and against of 

1, although any values can be chosen. 

To produce a Uniform Confidence plot, select the menu item from the ‘Plots’ menu in the main 

TESLA window.  A dialog will appear (Figure 32), into which the confidence value to be assigned 

to leaf hypotheses can be selected using the two sliders. 
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Figure 32: The Uniform Confidence plot dialog.  On the left, the root hypothesis for the plot 
should be selected (which needn’t be the tree’s root hypothesis).  On the right, the level at which 
to apply the uniform confidence should be selected.  The confidence to apply is specified using 

the sliders at the bottom of the dialog. 

At the top are two panels, each showing a summary of the decision tree.  In the left panel the root 

hypothesis for the plot should be selected - this does not have to be the root hypothesis of the 

whole decision tree.  On the right, the level at which the uniform confidence should be applied 

should be selected.  Again, this does not have to correspond to leaf hypotheses in the decision 

tree.  Uniform confidence can be applied at any level.  All hypotheses at which the confidence will 

be applied are highlighted in light blue.  These are hypotheses at the same level as the selection, 

or any leaf hypotheses higher than the selection (but in the same branch, i.e., underneath the 

selected root hypothesis).  Press ‘OK’ to display the plot. 

The Uniform Confidence plot is similar to the Tree View display, but only the hypotheses between 

the selected root hypothesis and the selected leaf hypotheses are displayed.  An example plot 

where the uniform confidence was applied at the first level in the tree is shown in Figure 33.  This 

plot shows that our choices of tree parameters will allow a conclusive answer to be calculated for 

the root hypothesis “It will rain today”.  This may not always be the case, depending on the values 

chosen for sufficiency etc.  Usually, the parameterisation of trees that do not produce a conclusive 

result should be reconsidered. 
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Figure 33: A Uniform Confidence plot for the first level in the tree. 

By selecting alternative root hypotheses, it is possible to concentrate on branches of a tree rather 

than the whole decision.  For example, a Uniform Confidence plot for the “Weather forecast” 

branch of our tree is shown in Figure 34.  Here the parameterisation of the tree (specifically the 

dependency coupled with the sufficiency values) means that the confidence in support of the 

hypothesis “The weather forecast predicts rain” could never actually reach a value of 1.  This may 

indicate that the tree parameters need to be altered or that different contributing factors may need 

to be identified and added. 

   

Figure 34: A Uniform Confidence plot for the “Weather forecast” branch. 

6.2 Tree Plot 
The Tree Plot is the standard TESLA view of the hierarchy of hypotheses.  Using flags, it shows 

how confidence in the leaf hypotheses propagates to the root hypothesis, as well as indicating 

how the tree has been parameterised.  By looking at the root hypothesis the decision maker can 

judge whether, given the confidence values assigned to the leaf hypotheses and the tree 

parameterisation, the root hypothesis is sufficiently conclusive.  See Section 5.2. 

6.3 Confidence Flow Lines 
Confidence flow lines and percentage contributions of the leaf hypotheses to the root can be 

added to the tree plot to provide additional information about the flow of confidence through the 

tree.  The flow lines can help to identify which leaf hypotheses (and ultimately, evidence sources) 

are contributing (or not contributing) to the root hypothesis outcome and by how much.  They can 

also be used to check the influence of logic on the propagation of confidence through the tree. 
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Figure 35 demonstrates these features using the umbrella example.  The flow lines help to 

highlight that all confidence in favour of rain originates from the weather forecast, whereas all 

confidence against rain originates from direct observation of the local weather.  It also highlights 

that even though there is strong confidence that any rainclouds present are rain-bearing, this does 

nothing to increase confidence in the hypothesis that it will rain.  This is because there are too few 

clouds, and with the ALL parameterisation there is a requirement for some confidence in there 

being more than 80% cloud cover for this to have an impact. 

   

Figure 35: The Flow of Confidence for the Umbrella Example.  The flow lines show the 
contributions of confidence to the root hypothesis. 

The option to visualise the flow of confidence through the tree can be toggled by selecting the 

“Show Flow of Confidence” item from the View menu.  Once this has been enabled, several further 

options are made available, which are configurable via View > Confidence Flow Options. 

• The flow lines can be chosen to indicate the percentage contribution of each hypothesis 

to its parent, or to the root hypothesis. (The default is to show the percentage contribution 

to the root.  The percentage contribution to a parent can be useful when analysing the 

influence of logic on a particular hypothesis and its children, or when comparing small 

contributions from leaf hypotheses of larger trees.) 
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• There is an option to toggle the display of the percentage contribution of each leaf 

hypothesis to the root hypothesis3. 

6.4 Ratio Plots 
A Ratio Plot is used to analyse a decision once confidence values have been input.  It summarises 

graphically the confidence values for all selected hypotheses.  It is structured to enable 

identification of hypotheses for which the balance of confidence is weak (neither strongly 

supporting nor strongly refuting the hypothesis), and those for which there is a lack of, or conflict 

in confidence (large residual uncertainty due to uncommitted or over-committed confidence).  To 

produce a Ratio plot, simply select the menu item from the ‘Plots’ menu in the main TESLA 

window. 

The horizontal axis of the Ratio plot indicates the percentage residual uncertainty, with an 

increasing negative value representing increasing conflict. 

The vertical axis indicates the ratio of confidence for to confidence against.  To avoid division by 

zero in this calculation, all confidence values are moved into the range [0.01, 1] (confidence values 

lying below this range are set to the bottom boundary value).  This results in a possible ratio 

between 0.01 and 100.  The calculated values are then plotted using a logarithmic scale. 

 

 

Figure 36: Regions of the Ratio plot. 

 

3 Note that when logical operators and the necessity heuristic are being used, there are special 

cases whereby it is impossible to identify which hypothesis is contributing confidence to the parent 

ambiguously. (For example, the maximum confidence may be being propagated, and several 

hypotheses may be providing the same maximum level of confidence.) In such situations, each 

such hypothesis is treated as contributing all the confidence.  Therefore, the percentage 

contributions may sum to more than 100% for certain special cases. 
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The background of the plot is shaded to indicate areas where confidence values are greater than 

or less than 0.5.  Along with the two axes, this splits the plot up into eight distinct regions, 

summarised in Figure 36.  The user may also define custom ratio plot regions, as described below 

in Section 6.4.1.  Points that lie in the dark green or dark red areas indicate more conclusive levels 

of confidence, i.e., the confidence for (or against, in the red region) is greater than 0.5 and the 

confidence against (or for, in the red region) is less than 0.5.  The nearer to the top or bottom of 

the vertical axis the point lies, the greater confidence there is that the hypothesis is true or false. 

A Ratio plot for the example we have been following is shown in Figure 37.  Most of the 

hypotheses, including the root hypothesis (labelled 1 in the Ratio plot), lie in either the dark green 

or dark red areas, indicating that there is strong confidence that they are either true or false.  The 

point labelled 6 on the plot (corresponding to “People outside have umbrellas up” lies in the lighter 

red region, indicating that there is a lack of confidence about the truth or falsehood of this 

hypothesis.  This may lead us to do some more research in that area (spending longer looking out 

of the window for example, to see more people go by). 

 

  
 

Figure 37: Ratio plot for the umbrella example.  Each numbered circle represents a hypothesis, 
as indicated in the legend.  The root hypothesis (1) lies within the dark green area indicating that 

there is strong confidence that the hypothesis is true. 

6.4.1 User-Defined Ratio Plot Regions 

As depicted in Figure 36 and described above, the coloured regions of the Ratio plot indicate 

areas where there is stronger and weaker confidence that hypotheses are true and false.  By 

default, the ratio plot is split into 4 distinct regions based on the values of confidence for and 
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against.  The user can specify their own regions on the Ratio plot by selecting ‘Options...’ from the 

‘Tree’ menu in the main TESLA window and clicking the ‘Ratio Plots’ tab (Figure 38). 

Select the ‘User Defined’ radio button to activate the user-defined regions.  TESLA provides some 

suggestions, but these can be altered as desired; a maximum of 5 regions can be specified.  Enter 

the region names and confidence ranges as required, and press ‘OK’ to commit the changes. 

The Ratio plot for our example with user-defined regions is shown in Figure 39.  With this greater 

refinement of regions on the plot, the root hypothesis lies in the “Significant Doubt” band indicating 

that whilst the balance of confidence is in favour of the hypothesis being true, there is a sufficient 

lack of confidence, and sufficient confidence that the hypothesis is false, to cast doubt on the 

outcome. 

  

Figure 38: User-defined regions for the Ratio plot can be specified in the Options dialog (located 
under the Tree menu). 
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Figure 39: A Ratio plot with user-defined regions. 

6.5 Tornado Plots 
Like Ratio plots, Tornado plots are designed to analyse trees that have been populated with 

confidence values.  The aim of the Tornado plot is to calculate the impact that the confidence 

values of each leaf hypothesis have upon the overall decision; that is, how sensitive the root 

hypothesis confidence values are to small changes in the confidence values of the leaf 

hypotheses.  This can aid the decision maker by identifying areas where extra research to improve 

confidence is valuable, and areas where it would have little or no effect. 

This is a differential calculation.  It is implemented in TESLA by temporarily incrementing the 

confidence values of each leaf hypothesis in turn by a marginal amount, noting the change in 

confidence values of the root hypothesis.  The sensitivity of the confidence values at the root 

hypothesis will depend upon the confidence values that have been assigned to the leaf 

hypotheses and on the way the tree has been parameterised. 

The impact, calculated separately for confidence for and confidence against, is defined as: 

change in confidence value of the root hypothesis

change in confidence value of the leaf hypothesis
 

The calculated impact for each type of confidence is converted to a percentage and plotted as a 

horizontal bar on the Tornado plot.  This bar is coloured green to indicate sensitivity to confidence 

for and coloured red to indicate sensitivity to confidence against. 
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The hypotheses are plotted in descending order of total impact, thereby giving the whole plot its 

tornado-like appearance from which it takes its name.  The hypotheses are listed in a legend 

underneath the plot, in ranked order.  

To generate a Tornado plot, simply choose the menu item from the Plots menu in the main TESLA 

window.  A plot generated for our example tree is shown in Figure 40.  

Here we see that the top-ranked hypothesis is “The local newspaper forecast predicts rain”.  This 

means that if a small change is made to the confidence for value of this hypothesis, there would 

be a (relatively) large change to the confidence for value of the root hypothesis.  Thus, it might be 

a good idea to try to reduce the amount of residual uncertainty here by conducting some more 

research.  

  

Figure 40: A Tornado plot generated for the umbrella example. 

   

Note that empty tornado plots may be produced if some hypotheses are necessary and always 

result in the failure of the root hypothesis.  This is because TESLA is correctly showing that small 

perturbations to the leaf hypotheses have no effect in this case as the confidence from the 

necessary hypotheses is propagated favourably instead.  If the necessary hypothesis does not, 

by itself, cause the failure of its parent then the tornado plot will not be empty. 

A similar effect is also seen if the propagation method has been overridden by specifying that all 

child hypotheses are necessary for a particular parent hypothesis.  This is the case for our 

example tree where the sibling hypotheses “The clouds are rain-bearing” and “There is significant 

cloud cover” are both marked with “ALL”.  As seen in Figure 40, the impact of “The clouds are 

rain-bearing” on the root hypothesis is shown to be zero, since it is always the minimum 

confidence value from the pair that is propagated (and thus changing the value of one may not 

affect the value of the parent). 

An important point to note is that as Tornado plots consider the sensitivity of the tree to small 

variations in leaf level confidence values, they do not always capture the overall sensitivity of the 

tree to larger changes in such values, which might ‘trip’ certain logical criteria and lead to markedly 

different overall outcomes.  Changes in success/failure of ‘necessary’ hypotheses, and of the 
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‘weakest’ or ‘strongest links’ from groups of hypotheses whose confidence propagation is 

controlled by ALL or ANY logical constructs are examples of this.  Thus, while the Tornado plot is 

a powerful analysis tool, it needs to be carefully used with these factors in mind. 
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7 Outputs 
TESLA provides a variety of methods for outputting information about a decision, which are 

summarised in this section. 

7.1 Tree Plots 
One of the most important outputs from TESLA is the decision tree itself.  Whilst screenshots of 

the Tree View display can be taken for inclusion in reports etc., the Tree plot produces a copy of 

the Tree View and can be used to display both the whole tree and branches of a tree.   

To draw a Tree plot, select the menu item from the ‘Plots’ menu in the main TESLA window.  If a 

plot of a branch is required, rather than the entire tree, select the desired root hypothesis in the 

Tree View display first.  Once a Tree plot has been drawn, it can be printed or saved as an image 

for inclusion into a report via the options on the File menu. Figure 41 shows a Tree plot of a branch 

of the example tree. 

Any selected confidence flow options will also be reflected in the tree plot. 

  

Figure 41: A Tree plot of a portion of the example decision, with flowlines indicating the 
contribution of each child hypothesis to the confidence of the parent. 

7.2 Decision Summary Reports 
TESLA can automatically produce summaries containing information about all aspects of the 

decision.  These summaries can be produced as Word or PDF documents, and can either be in 

Report format (portrait, comprehensive information, can be used as a standalone document or as 

part of a larger report) or Presentation format (landscape, larger fonts and contain just the most 

important points about the decision). 

To produce a summary report, choose ‘Create Report...’ from the ‘Reports’ menu in the main 

TESLA window.  A dialog like the one shown in Figure 42 will be displayed.  From here the report 

type and format can be selected.  As well as Word and PDF formats, reports can be displayed on-

screen in the Report Viewer tool.  Reports viewed in this fashion can also be exported directly 

from the Report Viewer tool to Word or PDF format. 

Some elements of the report are optional, such as tables of reasons for selecting confidence 

values, lists of linked reference files and the various plots.  Use the check boxes to select which 

elements to include in the report. (Note that some elements are not available in Presentation 

reports). 
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Figure 42: The Report Choices dialog (select ‘Create Report’ from the ‘Reports’ menu).  From 
here the report type, format, elements and level of detail can be specified. 

In addition, the level of detail to include in the report can be chosen from the Report Choices dialog 

using the radio buttons at the bottom.  The choices are as follows: 

1. Whole Tree.  Information about the entire tree is included in the report, from root to leaf 

hypotheses. 

2. Root Hypothesis + Children.  Only information about the root hypothesis and its 

immediate children are included.   

3. Truncated Tree at...  Use the drop-down box to select the level at which to truncate the 

tree.  Level 0 represents the root hypothesis; Level 1 is the children of the root; Level 2 is 

their children etc.  Thus, selecting Level 1 here would be equivalent to selecting “Root 

Hypothesis + Children”. 

4. From Hypothesis...  This option allows you to report on a single branch of the tree.  Use 

the first drop-down to select the root hypothesis for the tree, and the second to select the 

level at which to truncate the tree.  As described above, Level 0 is the root hypothesis; 

Level 1 is the children of the root; Level 2 is their children, etc. 

Once the report options have been chosen, click OK to generate the report.  If Word or PDF 

formats have been chosen, then you will be asked to provide a filename for the report.  The report 

will then be created, and displayed in the default application for that format (e.g.  Microsoft Word 

or Adobe Reader).  A section of a summary report (in Report format) is shown in Figure 43.  
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Figure 43: Excerpt from a summary report generated by TESLA (Report format) 

7.3 Leaf Reason and Action Summary File 
In addition to the summary reports described in Section 7.2 above, a CSV (comma-separated 

value) file can be produced by TESLA summarising all the reasons entered against leaf 

hypotheses for selecting confidence values, and all outstanding actions to reduce the residual 

uncertainty and to improve the balance of confidence. 

To produce a leaf summary file, select ‘Create Leaf Summary CSV File...’ from the ‘Reports’ menu 

in the main TESLA window.  An excerpt of a file is shown in Figure 44.  As this is a CSV file, there 

is no formatting.  However, formatting can be applied manually later using Microsoft Excel (or 

another spreadsheet tool that accepts .csv files). 

  

Figure 44: Excerpt of a leaf summary CSV file, which contains the reasons and actions entered 
against each leaf hypothesis in the tree. 

If a hypothesis has multiple reasons or actions entered against it, it will have multiple lines in the 

file (e.g., hypothesis 2.2 “The clouds are rain-bearing” in the example shown in Figure 44, which 

has two actions to reduce residual uncertainty entered against it). 
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8 Managing the File Library 
As described in Section 5.4.1, TESLA allows the user to link reference files to hypotheses.  The 

File Library is used to manage these files and is described in detail in this section. 

8.1 The Tree Library 
The Tree Library contains all the reference files that have been linked to the current tree (this 

includes files that may have been linked to previous versions of the tree but may no longer be 

required).  Whenever a new file is attached to a hypothesis, it will be added to the Tree Library. 

To view or edit the Tree Library, select ‘Manage Reference Files...’ from the Tree menu in the 

main TESLA window.  The Reference Document Manager dialog will appear, as shown in Figure 

45.  All the files currently used in the tree are listed here.  The ‘Description’ field can be edited to 

provide information about what the file contains.  The ‘Status’ field indicates whether the file is 

embedded in the tree file (“Embedded”), not embedded but available locally (“In Library”) or could 

not be found (“Missing from Library”). 

  

Figure 45: The Reference Document Manager dialog.  This lists all the documents that have 
been referenced in the current tree. 

Reference files can either be linked or embedded.  An embedded file is included in the tree and 

is saved (in binary format) within the decision file itself.  Although this can lead to bulky files, it 

allows the user to easily share their trees and reference files with others without having to worry 

about manually collating the reference files. 

A linked file is simply stored locally on the user’s computer as a separate file and is accessed 

when required.  When the tree is saved, options will be provided to either embed linked files or 

leave them as separate entities. (See Section 8.3 for details.) 

To embed a single file, right-click on it in the Reference Document Manager dialog and select 

‘Embed...’ from the pop-up menu.  To embed all files in the library, click the ‘Embed All’ button.  

Similarly embedded files can be detached by right-clicking and selecting ‘Detach...’ or clicking the 

‘Detach All’ button.  To view a file, right-click on it and select ‘Launch...’.  It will be launched in 

read-only mode using the default application. 

8.2 The Local Library 
The Local Library is a repository on your computer for all the files that have been linked to TESLA 

decision trees.  It enables you to quickly and easily locate reference files that are used regularly 

in your decisions, and as it is a central repository containing copies of the files it guards against 

accidental deletion or the moving of important files. 

Any reference file added to the Tree Library must also be added to the Local Library.  To manage 

the Local Library, select ‘Manage Local Library’ from the ‘File’ menu in the main TESLA window 

to bring up the Library Manager (Figure 46). 
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Figure 46: The Local Library Manager dialog.  This displays the contents of your TESLA file 
repository, covering all decision trees that have been created. 

The Library Manager shows the file details, including a description which can be edited by clicking 

twice in the cell.  The “Status” column indicates whether the file is “Available” or “Missing”.  Missing 

files may have been deleted accidentally from the central repository outside TESLA.  It is not 

recommended that the library should be edited in any manner other than via the Library Manager 

within TESLA.  The “TESLA Files” column lists the filenames of decision trees on the local 

computer to which the file is known to have been linked. 

To add a new file to your library, click the “Import” button and browse for the file.  To delete a file, 

select it from the list and click “Delete”.   

8.3 Saving Trees with Linked Files 
There are 3 options available when saving a decision tree file containing linked reference files: 

1. Embed.  The files can be embedded as binary objects in the tree file itself.  This means that 

the files and the tree are intrinsically linked and eliminates problems of missing reference 

files.  It allows users to share trees easily.  However, it can lead to bulky decision tree files.  

Choose this option if you want to share your tree and only have a few linked reference files. 

2. Archive.  The files can be combined into a TESLA document archive (.tda file), which can 

be distributed independently from the tree but ensures that the reference documents are 

held together in a single location and clearly marked as being part of a TESLA tree.  The 

TESLA document archive file is saved in the same folder as the TESLA tree file (.tes).  

When loading a TESLA tree file, if a corresponding document archive is present in the same 

folder, TESLA will read the documents from the archive file and add them to the local library 

if necessary.  Choose this option if you want to share your tree and have many linked 

reference files. 

3. Omit.  The files can be omitted from the tree file but retained locally.  This means that other 

users you share your tree with will not be able to view the linked files, but the decision tree 

file will be small.  Choose this option if you do not need to share your tree or if the linked 

files are not important when sharing. 
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Figure 47: This dialog appears when a decision tree containing linked files is saved.  It allows 
the user to embed, archive or omit the linked files. 
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9 Working with Sub-Trees 
Decision trees created with TESLA can often be complex, with many hypotheses and levels.  

Often it helps to work on individual parts of the tree and focus on the issues involved there rather 

than in the context of the whole decision.  TESLA allows the user to identify a branch of the tree 

to work on, break it off from the main tree, alter parameters and values without affecting the main 

tree, and then subsume the changes back into the main tree (or cancel). 

  

Figure 48: Working on a Sub-Tree. 

To start working on a sub-tree, in the Tree View display select the hypothesis that will be the root 

of the branch to be worked on.  Right-click and select ‘Work on Sub-Tree’ from the pop-up menu.  

A new tab will be opened containing the selected branch as a separate tree.  See Figure 48 for 

an example, which shows a Sub-Tree for the hypothesis “The weather forecast predicts rain” of 

the Umbrella decision.  Make all the changes necessary here - the main tree will be unaffected - 

and when ready, click the ‘Apply’ button at the bottom of the window to subsume the changes 

back into the main tree.  Click ‘Cancel’ to return to the main tree without accepting the changes. 

Sub-Trees are useful when parameterising the tree since it allows the behaviour of the branch to 

be studied in detail and independently.  It is also useful when entering confidence values since it 

enables the assessors to focus on the branch in question, independently of and without undue 

influence from hypotheses elsewhere in the tree.  This is of particular help in a group workshop 

environment. 
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10 Version Control 
TESLA includes built-in version control that records the history of changes made to a decision 

tree. 

10.1 Tree Versions 
A new tree version is created whenever a tree is closed and re-opened or when a tree is reviewed 

or approved. (See Sections 10.3 and 10.4.)  Saving does not create a new version.  Previous 

versions are listed in the Change Log and can be viewed at any time.  The current version number 

of a tree is shown on the Decision Details dialog and in brackets after the tree title on the tab label 

of the Tree View display. 

10.2 Change Log 
All versions and a list of the changes they include are recorded in the Change Log, which can be 

accessed either from the Decision Details dialog or the ‘Tree’ menu.  The Change Log dialog is 

shown in Figure 49. 

 

Figure 49: The Change Log dialog. 

The Change Log shows each version number, the date it was modified and the user who modified 

it (as entered in the Decision Details dialog when a tree is opened).  By clicking the plus sign next 

to an individual version, it can be expanded to show full details of the changes included in that 

version. 

10.2.1 Viewing an Old Version 

Every version of a tree is stored and can be viewed at any point by selecting it from the Change 

Log and clicking ‘View’.  The old version will be opened in a new tab in the main TESLA window, 

and all the information in it can be viewed but not edited. 

10.2.2 Rolling Back 

It is possible to “roll back” to an old version of a tree, losing all changes that were made to the tree 

after that version.  To roll back, simply select the tree version in the Change Log and click ’Roll 

back’.  The tree will be replaced in the main TESLA window by the selected version.   

It is not possible to roll back past a reviewed or approved version of a tree. (See below.) 

10.2.3 Exporting an Old Version 

Rather than rolling back to an old version, you may wish to edit an old tree without losing the 

changes made to the current version.  In this case, the old tree should be exported, i.e., saved as 

a separate tree file, which can then be edited whilst retaining the original tree. 
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To export an old version, select the version in the Change Log and click ‘Export...’.  This will open 

the old version of the tree in a new tab, from where it can then be edited and saved under a 

different filename.  This method will retain the version history up to that point.  Alternatively, to 

discard its version history, click the root node, copy it (e.g., via Ctrl+C or right-click and Copy), 

then paste as a new tree before saving (e.g., via Ctrl+Shift+V or right-click > Paste As… > New 

Tree). 

10.2.4 Labelling Versions 

To allow the user to quickly identify versions in the Change Log, it is possible to label specific 

versions.  To label a version, select it in the Change Log window and click ‘Label...’.  Enter a label 

for the version in the box that appears (Figure 50) or select an existing one from the drop-down 

list, and press ‘OK’ to apply the label. 

 

Figure 50: Labelling a version in the Change Log. 

Version labels are shown in brackets in the Change Log after the version number, as shown in 

Figure 51.  Versions that have no label applied are marked as “Unlabelled”.  The check box ‘Only 

Show Labelled Versions’ can be used to restrict the view in the Change Log window to just those 

versions which have a label applied. 

 

Figure 51: A Change Log dialog showing labelled versions. 

10.3 Reviewing a Tree 
Once a tree has been completed it might be peer reviewed.  TESLA allows trees to be marked as 

“Reviewed”, recording the date of the review and the name of the reviewer.  To mark a tree as 

having been reviewed, select ‘Actions’ and then ‘Review’ from the ‘Tree Specific Actions’ in the 

‘Tree’ menu.  Enter the name of the reviewer in the dialog that appears and press ‘OK’.  You will 

then be asked to provide a label for the reviewed version; the default is “Reviewed” but you may 

choose any label you wish. 

Reviewing a tree will cause the tree version number to be incremented.  The reviewed version will 

be visible in the Change Log both by its label and “REVIEWED” following the name of the last 

editor of the tree (Figure 52). 
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Figure 52: A Change Log dialog, showing a reviewed version. 

Once a tree has been reviewed, it is not possible to roll back to versions prior to the reviewed 

version.  However, it is possible to edit the current tree.  Trees that have been reviewed and 

subsequently edited are indicated as such on their Decision Details dialogs. 

A tree may be reviewed any number of times, and each review version is clearly marked in the 

Change Log. 

10.4 Approving a Tree 
A tree can only be approved once it has been reviewed.  To mark a tree as having been approved, 

select ‘Actions’ and then ‘Approve’ from the ‘Tree Specific Options’ in the Tree menu.  Enter the 

name of the approver in the dialog that appears and press ‘OK’.  You will then be asked to provide 

a label for the approved version; the default is “Approved” but you may choose any label you wish. 

Approving a tree will cause the tree version number to be incremented.  The approved version 

will be visible in the Change Log by its label, “APPROVED” following the name of the last editor 

of the tree, and the entry being in a bold typeface. (See Figure 53.)  The check box ‘Only Show 

Approved Versions’ can be used to restrict the Change Log view to only approved versions. 

 

Figure 53: A Change Log dialog, showing an approved version in bold. 

Once a tree has been approved, it is not possible to roll back to versions prior to the approved 

version.  However, it is possible to continue editing the current tree.  The approved version will be 

retained in the Change Log and can be viewed at any time.  Edited trees are marked as 

unreviewed and unapproved in the Decision Details dialog. 

A tree may be approved any number of times, though it may only be re-approved after it has been 

re-reviewed.  The review/approval cycle is summarised in Figure 54. 
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Figure 54: The review and approval cycle. 

Unreviewed, 
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Reviewed 
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(with Edits) 
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11 Designing and Exporting Templates 
In some situations, it can be useful to use the same hierarchy of hypotheses to assess multiple 

options or even projects.  For example, when choosing a site for a new supermarket, the same 

factors may be assessed for each candidate site to enable them to be readily compared.  TESLA 

allows users to design and export template trees, which can then be used across multiple options 

or projects.  This ensures that the same tree structure is used in each case.  In addition, TESLA 

allows the creators of the template trees to embed guidance that can be accessed by the people 

populating those trees.  This section describes how to create a template tree and how to generate 

new trees based on an existing template. 

Once multiple trees based on the same template have been populated then, provided the structure 

of these trees has not been changed, they can be compared in TESLA using the portfolio tool.  

This is described in Section 12. 

11.1 Designing a Template 
A template tree starts life as a normal tree.  It is only at the final stage of creation when it becomes 

a template.  To create a template, start a new tree or open an existing tree as normal.  You should 

ensure that the tree structure is logically arranged and well explained, and that any linguistic 

mappings (Section 5.3.1) or user-defined ratio plot regions (Section 6.4.1) have been set up. 

11.1.1 Entering Template Guidance 

Guidance can be provided by the template designer that will subsequently be made available to 

users of trees derived from the template when they input confidence values.  This guidance can 

include guideline confidence values (for example, to delimit expected attainable values), sources 

of evidence, discussions of how to map evidence to numerical values etc. 

Template guidance can be added to any tree that has not been based on an existing template.  

To add template guidance to a hypothesis, double-click the hypothesis to bring up the Hypothesis 

Properties dialog and select the “Template Guidance” tab (note that this tab only appears for leaf 

hypotheses). 

 

Figure 55: The Template Guidance tab. 
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Use the sliders to input guideline confidence values that you wish users of your template to see.  

An explanation, or any other notes, can be entered into the “Explanation” box.  Again, this will also 

be visible by users of your template.  It is also possible to link supporting documentation to the 

Template Guidance tab, using the controls on the right - this feature works in a similar manner to 

the reference files described in Section 5.4.1.  Within the ‘Add Document’ dialog, it is also possible 

to specify a relevant page within the document.  If the document is a PDF, then when the template 

user views the file, it will automatically open at that page.  If the document is not a PDF, the page 

number acts as a guide to the user who will have to navigate to the correct page manually. 

11.1.2 Pre-Defined Version Labels 

As a template designer, you may wish to specify a set of version labels that template users can 

apply to their trees at various stages of the tree development process.  To do so, open the Change 

Log (via the Tree menu or Decision Details dialog) and click the ‘Pre-defined Labels...’ button.  

The dialog that appears (Figure 56) lists all the labels currently used in the tree.  New ones can 

be added by typing the label text in the box at the bottom and clicking “Add”.  Labels created via 

the Change Log, using the method described in Section 10.2.4, will automatically be added to the 

list.  

Any labels added to the list of pre-defined labels will be available from the drop-down box that 

appears when a user labels a version in the Change Log. (See Section 10.2.4 for details.) 

 

Figure 56: The pre-defined labels dialog. 

11.1.3 Exporting the Template 

To create a template tree, select ‘Export as Template...’ from the File menu.  Your tree will be 

saved with the .tem file extension instead of the usual .tes extension.  If you wish, you may enter 

a password to protect the tree structure.  If you choose not to specify a password, then users of 

trees derived from the template will be able to change its parameterisation and structure 

(adding/removing hypotheses).  If a password is applied, then users will only be able to enter 

confidence values, add to the audit trail and produce plots and reports.  All other features will be 

restricted by the password. 

The .tem file can then be distributed to users who are working on individual projects.  Note that 

the .tem file cannot be opened directly like a tree.  It can only be used to generate new trees that 

derive from that template.  Therefore, if further updates need to be made after creating a template, 

these should be made to the original .tes file and a new template should be exported. 
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Note that any confidence values and reference documents attached to hypotheses in the tree will 

be removed from the exported template file, leaving just the tree structure, parameters and 

supporting guidance documents.  Users of a template are expected to fill in their own confidence 

values. 

11.2 Deriving a Tree from a Template 
If you have been provided with a template file (ending in .tem), start a new tree based upon it by 

launching TESLA and selecting ‘New from Template...’ from the ‘File’ menu.  Select the template 

file (.tem) from the file browser.  The derived tree will open in a new tab and can be worked upon 

and saved in the usual manner. 

If the template designer has locked the tree structure with a password, you will be prompted for 

this password if you try to make any modifications other than those related to the input of 

confidence values.  If you have been supplied with the password, then you only need enter it once 

per session to unlock the tree structure.  

11.2.1 Viewing Template Guidance 

The ‘Template Guidance’ tab described in Section 11.1.1 is not available in trees that are derived 

from a template, but any information entered in this tab by the template designer is visible instead 

on the ’Evidence’ tab.  Guideline confidence values are shown as washed-out green and red bars 

in the Italian flag as shown in Figure 57.  Click the ‘Show Guidance’ button to slide out the 

Template Guidance pane on the right of the dialog.  The explanation for the guideline values is 

shown in the ‘Explanation’ tab.  The ‘Supporting Documentation’ tab shows a list of documents 

added by the template designer.  Double-click a document (or select and press ‘View’) to open it 

in the default application for that document format. 

  

Figure 57: The Guidance pane on the ‘Evidence’ tab displays any guideline information entered 
by the template designer. 
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12 Comparing a Portfolio of Trees 
ESL allows the decision maker to study one hypothesis in detail.  There are occasions when it is 

desirable to compare multiple trees (e.g., if each tree represents a different option), or multiple 

versions of the same tree (e.g., to view how confidence has varied over time).  TESLA provides a 

portfolio tool for this purpose, which is explained in this section. 

12.1 Comparable Trees 
TESLA’s portfolio tool allows multiple trees to be compared.  Those trees may be in separate files 

(see Section 12.2) or may be multiple versions of a single file (see Section 12.3).  To compare the 

trees, TESLA checks that they represent the same hierarchy of hypotheses as defined by the 

hypothesis titles.  So, starting from the root hypothesis, the hypothesis titles must match, the titles 

of their children must match and so on.  For a given parent, it does not matter if the child 

hypotheses are ordered differently across the different trees. 

When launching a portfolio, TESLA will establish what differences in parameterisation there are 

between the trees, such as changes in logic, sufficiency, dependency, or simply in hypothesis 

descriptions and will warn the user about them on launch.  See Figure 58 for an example. 

  

Figure 58: A warning about differences in the parameterisation of trees in a portfolio 

12.2 Multiple Files 
It is possible to compare multiple trees stored in multiple .tes files using the portfolio tool, provided: 

• that every tree was based on the same template file, or on no template file; and 

• that every tree has the same structure as defined in Section 12.1. 

To open a portfolio of decision tree files, launch TESLA and select ‘Open Portfolio’ and then ‘From 

Files...’ from the File menu.  You will then be asked to select the files you wish to open.  These 

files must all be in the same directory on the computer.  Multiple files can be selected 

simultaneously by holding down the Ctrl key whilst clicking. 

If there are differences in parameterisation between the trees, a summary of the changes will be 

provided first.  (See Section 12.1.)  You will then be presented with a dialog (Figure 59) asking 

the order in which to display the trees in the portfolio tool.  Arrange the trees in the order you 

require by selecting each decision in turn and using the ‘Move Up’ and ‘Move Down’ buttons to 

re-order them.  When finished, press ‘OK’. 
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Figure 59: Selecting the order of the trees in the portfolio. 

The portfolio tool will then open, as shown in Figure 60.  Here we have compared multiple trees, 

each one representing a judgement on the weather conditions on a different day of the week.  We 

can only say whether it is cloudy or raining for the current day (Monday), because there is a lot of 

uncertainty, particularly in the lower half of the tree, from Tuesday onwards.   

Each tree in the portfolio is represented by a small, vertically orientated “Italian flag” image.  The 

number above the image can be used in conjunction with the legend to determine which tree is 

which.  The order of the trees can be changed at any time via the ‘Options’ item in the ‘Tree’ menu.  

Double-click any tree in the legend to open it up in a separate tab.  However, please note that any 

changes made to a tree will not be reflected in the portfolio tool unless it is closed and re-opened. 
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Figure 60: The portfolio tool, comparing multiple decision trees contained in separate files. 

12.3 Multiple Versions 
The portfolio tool can also be used to view multiple versions of a single decision tree.  (See Section 

10 for a discussion of version control.)  To open a set of versions from a single file, launch TESLA 

and select ’Open Portfolio’ and then ‘From Single File...’ from the ‘File’ menu.  You will then be 

asked to select the file you wish to open the versions from.  TESLA will compare all historic 

versions of the tree that have a hypothesis structure that is comparable with the most recent 

version. (See Section 12.1.) 

Once the file is selected, a list of versions found within that file will be displayed.  Select the 

versions you wish to include in the portfolio and press ‘OK’.  If there are differences in 

parameterisation between the chosen trees, a summary of the changes will be provided.  Finally, 

you will be asked to select the order of the versions in the portfolio, as shown in Figure 59.  This 

can be changed at any point from the ‘Options’ item in the ‘Tree’ menu. 

A portfolio of versions behaves in a similar fashion to a portfolio of multiple trees. (See Section 

12.2.) 
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12.4 Plots 

12.4.1 Tree Plot 

The tree plot for the portfolio behaves as described in Section 7.1 for standard trees. 

12.4.2 Single-Hypothesis Ratio Plot 

The Single-Hypothesis Ratio plot is similar to the standard Ratio plot (see Section 6.4) but only 

includes a single hypothesis and displays that hypothesis for each of the trees/versions in the 

portfolio on the same plot.  For example, Figure 61 shows a Single-Hypothesis Ratio plot for the 

root hypotheses of the portfolio of trees shown in Figure 60. 

To draw a Single-Hypothesis Ratio plot, select the hypothesis to plot in the Tree View display and 

select ‘Single-Hypothesis Ratio Plot’ from the ‘Plots’ menu in the main TESLA window. 

  

Figure 61: A single-hypothesis ratio plot, generated by the portfolio tool.  This shows a single 
selected hypothesis for each tree/version in the portfolio. 

12.4.3 Ratio Plots for All Trees/Versions 

Ratio plots can also be produced for all trees/versions in the portfolio, as shown in Figure 62.  A 

single Ratio plot is shown for each tree/version and displayed in a grid.  Each Ratio plot shares 

the same legend.  This enables the user to easily compare Ratio plots across all trees/versions in 

the portfolio. 

To draw Ratio plots for all trees/versions in the portfolio, select ‘Ratio Plots for all Trees’ from the 

‘Plots’ menu. 
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Figure 62: A grid of Ratio plots for each tree/version in the portfolio. 

12.4.4 Tornado Plots for All Trees/Versions 

Similarly, Tornado plots (see Section 6.5) can be produced for each tree/version in the portfolio.  

The Tornado plots are displayed in a grid (Figure 63) and share a single legend, which is shown 

at the bottom.  Since the trees share a single legend, the hypotheses are ordered by position in 

the tree using the same numbers as the ratio plots, rather than by rank.  Numbering starts at 2 

rather than 1, since 1 represents the root hypothesis, which is only displayed on a Ratio plot. 

To draw Tornado plots for all trees/versions in the portfolio, select ‘Tornado Plots for all Trees’ 

from the ‘Plots’ menu. 
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Figure 63: A grid of Tornado plots for each tree/version in the portfolio. 

12.5 Summary Reports 
Summary Reports can be generated from a portfolio in the same manner as described in Section 

7.2 for standard trees.  Two options are available: A single report summarising the portfolio 

(choose ‘Create Report’ from the ‘Reports’ menu); or multiple reports, one for each tree in the 

portfolio. (Choose ‘Create Reports for All Trees in Portfolio’ from the ‘Reports’ menu.)  This latter 

option will produce a report that is identical to the standard report for an individual tree. 
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Appendix A: The ESL Propagation Algorithm 

Introduction 
The Evidence Support Logic (ESL) propagation algorithm comprises several models for how 

confidence in certain hypotheses may combine to give confidence in a parent hypothesis.  The 

user is responsible for choosing an appropriate model and parameterising it as part of their 

assessment, as described in Section 4.  This appendix describes the various models for 

propagating confidence in more mathematical detail. 

Historical Developments 
ESL was originally inspired by research undertaken at the University of Bristol in the 1990s into 

mathematical algorithms for modelling evidential support in information/knowledge-based 

systems and the development of supporting software tools.  For example: Cui and Blockley 

(1990), Hall, Blockley and Davis (1998) and Davis and Hall (2003).  Bowden (2004), working at 

Quintessa, considered how such techniques might be applied in the context of geological models, 

where knowledge is incomplete and uncertain, and this led to the development of the first version 

of TESLA, which implemented a basic propagation algorithm only.  At that time, the language 

being used was one of processes and process models, of propagation of evidence, and of success 

or failure of those processes.  Since then, TESLA has been extensively applied to support decision 

making, particularly in the context of complex assessments involving uncertainty, such as those 

relating to performance of geological systems.  For example, Shell – which contributed to the 

funding of the development of TESLA - have used it to assess the suitability of potential sites for 

storage of CO2 (Tucker et al, 2013).  TESLA has been used to assess the uncertainties associated 

with the estimation of geological uplift (Nakayasu, 2014).  TESLA has also been used as a tool to 

help communicate assessments used in regulatory approval submissions, for example to the UK 

Government’s Department of Energy and Climate Change (DECC) concerning a sub-surface risk 

assessment for the White Rose CCS Project (Capture Power Limited et al., 2016).  The model, 

software and the way it is understood and described have all evolved over time as experience 

with its application has developed.  As described in this guide, we now work with hypotheses, not 

processes and assess the degree to which those hypotheses are known to be true or false.  We 

accept that success and failure can have different meanings dependent on context, such that an 

assessment that a hypothesis is false may be considered a success.  We have introduced 

symmetric necessities as an alternative to asymmetric necessities accordingly.  Users supply 

supporting evidence at the leaf hypotheses and propagate confidence in the hypotheses through 

the model.  The confidence propagation model has been developed and expanded to give users 

more flexibility over how confidence is propagated from children to parent, such as via the 

introduction of heuristic operators. 

Presented below, is our current understanding of how best to interpret and describe the theory. 

Theory 
The algorithm can be thought of as being composed of two components: 

• A Confidence Model.  This is a mathematical model for confidence in the truth and/or 

falsehood of a hypothesis that allows for uncertainty and conflict.  At a leaf hypothesis, 

this is supported directly by evidence.  Elsewhere, this is supported by assessments of 

the truth/falsehood of child hypotheses. 
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• A Propagation Algorithm.  This models how confidence in child hypotheses affects 

confidence in their parent. 

These two aspects are described in the following sections.  In the final section, the theory is used 

to derive the algebraic expressions that model the fractional flow of confidence from leaves to the 

root (to level hypothesis), which are used to visualise confidence flow lines. 

The Confidence Model 
Confidence is quantified by a dimensionless number between 0 and 1, where 0 represents a 

complete lack of confidence (due to a complete absence of evidence on which to make a 

judgement) and where 1 represents complete confidence.  For a hypothesis, confidence that the 

hypothesis is true (given supporting evidence) and confidence that the hypothesis is false (given 

refuting evidence) are judged separately.  There may be evidence supporting both the truth and 

falsehood of the hypothesis.  Confidence that a hypothesis, 𝐻, is true (+) or false (-) is represented 

by the symbol 𝐶±(𝐻) .  The residual uncertainty, 𝑈(𝐻), is calculated as 𝑈(𝐻) = 1 − 𝐶+(𝐻) −

𝐶−(𝐻), and so may take values in the range -1 to 1, where the extreme value 1 represents 

complete uncertainty due to uncommitted confidence, and the extreme value -1 represents 

complete uncertainty due to over-committed confidence.  See Figure 64. 

Further interpretation of confidence for, confidence against and residual uncertainty are given in 

Section 5.1 and Section 5.2. 

 

Figure 64: Confidence for (𝑪+) and against (𝑪−) a Hypothesis, 𝑯. 

 

The Propagation Algorithm 
As currently implemented, TESLA includes several different methods for propagating confidence 

from children to a parent.  These are described below.  The default propagation method is referred 

to as the Basic Propagation Algorithm.  Several heuristic operators are available which, when 

enabled, override the default propagation algorithm: Necessities, ANY and ALL. 

0 ...................................................... 1 

0 ...................................................... 1 

1 ....................................................... 0 

Confidence for, 𝐶+(𝐻) 

Confidence against, 𝐶−(𝐻) 

Residual Uncertainty: 𝑈(𝐻) = 1 − 𝐶−(𝐻) − 𝐶+(𝐻) 
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The Basic Propagation Algorithm 

First, the algorithm will be specified for the general case of an arbitrary number of child 

hypotheses.  Then this will be illustrated by way of an example for a simple case. 

A hypothesis is a logical entity.  In the following, we will make use of the natural correspondence 

between logical operators and set theoretical operators to cast the problem as a set theoretical 

one.  As such, 𝐴 ∪ 𝐵 represents the union (logical OR) of two hypotheses and 𝐴 ∩ 𝐵 represents 

the intersection (logical AND).  We define a parent hypothesis, 𝐻 and a set of child hypotheses, 

𝐺𝐻, and use the notation 𝐶(𝑋) to denote the confidence that the hypothesis 𝑋 is either true or 

false.  Confidence for and against are propagated independently. 

General Case 

TESLA models the confidence in a parent hypothesis, 𝐻, as deriving from the union of confidence 

in its child hypotheses, 𝐺𝐻, as: 

 

𝐶(𝐻) ≡ 𝐶 (𝐻 ∩ [ ⋃ 𝑋

𝑋∈𝐺𝐻

]) = 𝐶 ( ⋃ [𝐻 ∩ 𝑋]

𝑋∈𝐺𝐻

) (1) 

This is illustrated for the case of two child hypotheses, 𝐺𝐻 = {𝐴, 𝐵}, in Figure 65. 

 

Figure 65: Venn diagram illustrating the propagation of confidence to a hypothesis, 𝑯, from two 

child hypotheses, 𝑨 and 𝑩.  The overlaps of 𝑯 with 𝑨 and 𝑩, 𝑯 ∩ 𝑨 and 𝑯 ∩ 𝑩, are related to 

sufficiency.  The overlaps between children, 𝑨 ∩ 𝑩, are related to dependency.  The area of 𝑯’s 

circle overlapped by 𝑨 and 𝑩 is related to the confidence in 𝑯 given confidence in 𝑨 and 𝑩. 

Using the principle of inclusion and exclusion, the confidence of a union can be expressed as a 

sum of the confidence of intersections: 

 

𝐶(𝐻) = ∑  (−1)𝑘−1 ∑ 𝐶 (⋂[𝐻 ∩ 𝑌]

𝑌∈𝐾

)
𝐾⊂𝐺𝐻
|𝐾|=𝑘

|𝐺𝐻|

𝑘=1

 (2) 

𝐻

𝐵𝐴

Confidence in 𝐻 
given confidence in 
𝐴 and 𝐵: 

𝐻 ∩ (𝐴 ∪ 𝐵) 
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Here |𝐺𝐻| represents the number of hypotheses contributing to the parent hypothesis, 𝐻, and the 

expression in the second summation, 𝐾 ⊂ 𝐺𝐻 , |𝐾| = 𝑘, represents all combinations of the subsets 

of the contributing hypotheses which contain exactly 𝑘 elements. 

By analogy with probability theory, the conditional confidence for hypothesis 𝐻 given the child 

hypothesis 𝑋  is introduced as 𝐶(𝐻|𝑋) , defined by 𝐶(𝐻 ∩ 𝑋) = 𝐶(𝐻|𝑋)𝐶(𝑋) .  In TESLA, the 

conditional confidence for a parent 𝐻  given a child 𝑋  is referred to as a sufficiency.  This is 

denoted by 𝑠𝐻𝑋, so that 

 𝐶(𝐻 ∩ 𝑋) = 𝑠𝐻𝑋𝐶(𝑋) (3) 

It is evaluated independently for confidence for and against.  If the child hypotheses are 

statistically independent in the context of the parent hypothesis, then again by analogy with 

probability theory (𝑃(∩ 𝑋) = ∏ 𝑃(𝑙)𝑙∈𝑋 ), we have 

 
𝐶 (⋂[𝐻 ∩ 𝑌]

𝑌∈𝐾

) = ∏ 𝐶(𝐻 ∩ 𝑌)

𝑌∈𝐾

= ∏ 𝑠𝐻𝑌𝐶(𝑌)

𝑌∈𝐾 

 (4) 

At the other extreme, if the child hypotheses are maximally dependent in the context of the parent 

hypothesis, such that there is a complete overlap in confidence, and from the point of view of set 

theory the confidence from one child hypothesis is a subset of the confidence from another, then 

we have 

 
𝐶 (⋂[𝐻 ∩ 𝑌]

𝑌∈𝐾

) = min
𝑌∈𝐾

(𝐶(𝐻 ∩ 𝑌)) = min
𝑌∈𝐾

(𝑠𝐻𝑌𝐶(𝑌)) (5) 

TESLA uses a dimensionless parameter, 𝐷𝐾 , to provide a linear mapping between these two 

extremes, with 0 representing statistical independence and 1 representing maximal dependency.  

Thus, 

 
𝐶 (⋂[𝐻 ∩ 𝑌]

𝑌∈𝐾

) = (1 − 𝐷𝐾) ∏ 𝑠𝐻𝑌𝐶(𝑌)

𝑌∈𝐾 

+ 𝐷𝐾 min
𝑌∈𝐾

(𝑠𝐻𝑌𝐶(𝑌)) (6) 

A single dependence parameter is used for parameterising confidence for and against. 

This general model, whereby it is possible to parameterise the dependency between each 

combination of child hypotheses independently, is referred to as alternative dependencies.  

TESLA also allows for a simpler parameterisation whereby the dependencies between all 

combinations of child hypotheses are treated as equal; 𝐷𝐾 = 𝐷  for all child hypothesis 

combinations, 𝐾. 

In summary, the propagation model from child hypotheses, 𝑋 ∈ 𝐺𝐻, to a parent hypothesis, 𝐻, in 

the absence of the application of ANY, ALL or necessity heuristic operators, is given by 

Equation (1) (and evaluated using Equation (2)), where the dependency between child 

hypotheses is given by Equation (6).  In these equations, 𝑠𝐻𝑋 are sufficiency parameters and are 

evaluated independently when propagating confidence for and against, 𝐷𝐾  are dependency 

parameters taking the same value when propagating confidence for and against, and 𝐾 

represents a combination of child hypotheses (where order of the hypotheses is not significant). 
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Simple Example 

Consider the case of a hypothesis, 𝐻, with two child hypotheses, 𝐴 and 𝐵, which are modelled 

using the basic propagation algorithm (with no operators applied).  The relationship between the 

parent and its children is illustrated with a Venn diagram in Figure 65.  The space where each 

hypothesis is true is depicted by a differently coloured circle.  The confidence in 𝐻  given 

confidence in its children 𝐴 and 𝐵 is depicted by the zone with a red boundary.  This area is 

calculated using Equation (1) with 𝐺𝐻 = {𝐴, 𝐵}, which simplifies to 

𝐶(𝐻) = 𝐶(𝐻 ∩ 𝐴) + 𝐶(𝐻 ∩ 𝐵) − 𝐶(𝐻 ∩ 𝐴 ∩ 𝐵) (7) 

The contribution from 𝐴 to 𝐻 when considered on its own is given by 

𝐶(𝐻 ∩ 𝐴) = 𝑠𝐻𝐴𝐶(𝐴) (8) 

which is represented by the overlap of 𝐴 and 𝐻.  Hypothesis 𝐵 follows the same pattern.  The final 

term takes account of the overlap of confidence between 𝐴 and 𝐵.  The contribution to confidence 

in 𝐻 due to dependency between child 𝐴 and 𝐵 is given by: 

 𝐶(𝐻 ∩ 𝐴 ∩ 𝐵) = (1 − 𝐷𝐴𝐵)𝑠𝐻𝐴𝐶(𝐴)𝑠𝐻𝐵𝐶(𝐵) + 𝐷𝐴𝐵 min(𝑠𝐻𝐴𝐶(𝐴), 𝑠𝐻𝐵𝐶(𝐵)) (9) 

where 𝐷𝐴𝐵 is the dependency of 𝐴 and 𝐵. 

The Necessity Heuristic 

The basic concept underlying the necessity heuristic is to make sure that if any necessary 

hypotheses fail a confidence test, then the confidence in the parent can be no better than this.  

There are currently two necessity heuristics in TESLA: symmetric and asymmetric. 

Asymmetric Necessity Heuristic  

If the asymmetric heuristic is used, then a definition of failure must be set.  This is a tree property.  

There are two choices: 

• Option A: confidence for is less than a half, or 

• Option B: confidence against is greater than a half 

The confidence values, both for and against, are then propagated directly from the failing 

hypothesis.  However, if the propagation algorithm leads to even less confidence, then these 

values are used instead.  

The algorithm is implemented as set out in Figure 66. 

Symmetric Necessity Heuristic 

If the symmetric necessity heuristic is used, then confidences for and against are kept separate 

and two definitions of failure are used.  When considering the propagation of confidence for, failure 

is defined as confidence for less than a half, and when considering the propagation of confidence 

against, failure is defined as confidence against greater than a half.  As with the asymmetric 

heuristic, the confidence values of the parent are first calculated using the propagation model.  

Then the algorithm given in Figure 67 is applied. 
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set the parent’s confidence for and confidence against to the values obtained using the 
propagation algorithm 
 
for every necessary child (𝐶, say) 
{ 

if option A 
{ 

if 𝐶’s confidence for is less than a half 
and 
( 

𝐶’s confidence for is less than the parent’s current confidence for 
or 
( 

𝐶’s confidence for is equal to the parent’s current confidence for 
and 
𝐶’s confidence against is greater than the parent’s confidence against 

) 
) 

 { 
replace the parent’s confidence for and confidence against by 𝐶’s  

} 
} 
else if option B 
{ 

if 𝐶’s confidence against is greater than a half 
and 
( 

𝐶’s confidence against is greater than the parent’s current confidence against 
or 
( 

𝐶’s confidence against is equal to the parent’s current confidence against 
and 
𝐶’s confidence for is less than the parent’s current confidence for 

) 
) 
{ 

replace the parent’s confidence for and confidence against by 𝐶’s  
} 

} 
} 

Figure 66: The propagation algorithm for the asymmetric necessity heuristic. 
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set the parent’s confidence for and confidence against to the values obtained using the 
propagation algorithm 
 
if the children are necessarily true, then 
{ 

for every necessary child (𝐶, say) 
{ 

if 𝐶’s confidence for is less than a half and less than the parent’s current confidence 
for 
{ 

replace the parent’s confidence for by 𝐶’s 
} 
 
if 𝐶’s confidence against is greater than a half and greater than the parent’s current 
confidence against 
{ 

replace the parent’s confidence against by 𝐶’s 
} 

} 
} 
 
else if the children are necessarily false, then 
{ 

for every necessary child (𝐶, say) 
{ 

if 𝐶’s confidence for is greater than a half and greater than the parent’s current 
confidence for 
{ 

replace the parent’s confidence for by 𝐶’s 
} 
if 𝐶’s confidence against is less than a half and less than the parent’s current 
confidence against 
{ 

replace the parent’s confidence against by 𝐶’s 
} 

} 
} 

Figure 67: The propagation algorithm for the symmetric necessity heuristic.  

ALL Operator 

This represents an assessment that confidence for (or against) the parent can be no better than 

that of the weakest of the child hypotheses.  With this operator, complete confidence in the parent 

can only be achieved if each child hypothesis, when considered on its own, provides complete 

confidence in the parent.  This is modelled by direct propagation of the minimum confidence 

values from among the child hypotheses, i.e. 

𝐶(𝐻) = min
𝑋∈𝐺𝐻

(𝐶(𝑋)) 

ANY Operator 

This represents an assessment that confidence for (or against) the parent is as good as the 

strongest of the child hypotheses.  With this operator, complete confidence in the parent is 

achieved if any child hypothesis, when considered on its own, is sufficient to provide complete 

confidence in the parent.  This is modelled by direct propagation of the maximum confidence 

values from among the child hypotheses, i.e. 
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𝐶(𝐻) = max
𝑋∈𝐺𝐻

(𝐶(𝑋)) 

Confidence Flow Lines 
In addition to propagating confidence through the tree, TESLA provides an option to visualise 

confidence flow lines.  These lines provide an indication of the flow of confidence from leaf 

hypotheses through to the root hypothesis.  The fraction of confidence contributed to the parent 

hypothesis or to the root is represented visually using the thickness of the confidence flow line. 

To draw these lines, a property, 𝐹𝐻𝑋, is calculated.  For a hypothesis, 𝐻, this property provides an 

estimation of the fraction of its confidence provided by each child hypothesis, 𝑋 .  As shown 

in Figure 65, child hypotheses overlap in confidence space, so there is ambiguity as to the origin 

of some of the confidence when there are multiple child hypotheses.  The basic expression TESLA 

uses for 𝐹𝐻𝑋 , has the advantage that it treats all hypotheses symmetrically with respect to 

dependency (or overlap). 

Derivation of Child Contribution to Confidence 

Since the dependency terms, given by Equation (6), are invariant under permutations of sibling 

hypotheses, we can express the second sum in Equation (2), which is over all subsets of 𝐺𝐻 of 

size 𝑘 as 

∑ 𝐶 (⋂[𝐻 ∩ 𝑌]

𝑌∈𝐾

)
𝐾⊂𝐺𝐻
|𝐾|=𝑘

=
1

𝑘!
∑ ∑ … ∑ 𝐶 ( ⋂ [𝐻 ∩ 𝑌]

𝑌∈{𝑔1,𝑔2,…,𝑔𝑘}

)
𝑔𝑘∈𝐴𝑘

𝐴𝑘=𝐴𝑘−1−𝑔𝑘−1

𝑔2∈𝐴2
𝐴2=𝐴1−𝑔1

𝑔1∈𝐴1
𝐴1=𝐺𝐻

 (10) 

where 𝑘! is the number of possible permutations of sibling hypotheses.  This expression has the 

advantage that it is symmetric with respect to child hypotheses4.  It therefore allows it to be 

decomposed it into contributions from individual child hypotheses in an unbiased manner.  Pulling 

out the outer sum and rewriting in the original condensed form without permutations (for 

computational efficiency), gives 

∑ 𝐶 (⋂[𝐻 ∩ 𝑌]

𝑌∈𝐾

)
𝐾⊂𝐺𝐻
|𝐾|=𝑘

=
1

𝑘
∑ ∑ 𝐶 (⋂[(𝐻 ∩ 𝑋) ∩ 𝑌]

𝑌∈𝐾

)
𝐾⊂𝐺𝐻−𝑋
|𝐾|=𝑘−1

𝑋∈𝐺𝐻

 
(11) 

Equation (2) can then be rewritten as: 

𝐶(𝐻) = ∑

[
 
 
 

∑
(−1)𝑘−1

𝑘
∑ 𝐶 ( ⋂ [𝐻 ∩ 𝑌]

𝑌∈𝐾∪𝑋

)
𝐾⊂𝐺𝐻−𝑋
|𝐾|=𝑘−1

|𝐺𝐻|

𝑘=1
]
 
 
 

𝑋∈𝐺𝐻

 (12) 

The term inside the large square brackets can be interpreted as the contribution from child 𝑋 to 

the total confidence.  Finally, the ratio of the amount of confidence contributed by child 𝑋 to the 

total amount of confidence contributed by all children 𝐺𝐻 of hypothesis 𝐻, can be expressed as 

 

4 It also has the computational disadvantage that it includes many more terms and so cannot be 

used for calculations from a practical point of view (~𝑁4 per hypothesis, where 𝑁 is the number 

of child hypotheses.) 
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𝐹𝐻𝑋 =
1

𝐶(𝐻)
∑

(−1)𝑘−1

𝑘
∑ 𝐶 ( ⋂ [𝐻 ∩ 𝑌]

𝑌∈𝐾∪𝑋

)
𝐾⊂𝐺𝐻−𝑋
|𝐾|=𝑘−1

|𝐺𝐻|

𝑘=1

 (13) 

when 𝐶(𝐻) > 0, and 0 otherwise. 

When heuristic operators are employed, this property may be overridden.  In place of the default 

algorithm, the following types of hypotheses are all ascribed 100% of the confidence (with their 

siblings ascribed none): 

• Necessary hypothesis/hypotheses in a failed state. 

• The weakest hypothesis/hypotheses when using ALL. 

• The strongest hypothesis/hypotheses when using ANY. 

If, when this occurs, multiple sibling hypotheses are equally as failed, or equally as weak or equally 

as strong, the convention used is that all of them are ascribed 100% (so that the total may be 

more than 100%). 



 User Guide for TESLA 2.2, v1.1 

 73 

Appendix B: Glossary of Terms 

Term Definition 

Branch A section of the tree, from a given hypothesis, incorporating all its 
descendants. 

Child Hypothesis A Hypothesis that has a Parent (i.e., any but the Root Hypothesis.) 

Confidence For Value between 0 and 1 indicating the strength of confidence that the 
hypothesis is true, based on evidence. 

Confidence 
Against 

Value between 0 and 1 indicating the strength of confidence that the 
hypothesis is false, based on evidence. 

Conflict When there is evidence lending confidence to a hypothesis being true 
and there is also evidence lending confidence to a hypothesis being 
false, this can be considered a conflicting state.  Furthermore, when 
confidence for and confidence against sum to more than 1, such that 
residual uncertainty is negative, this is referred to as over-committed 
confidence, indicating that there is over-confidence in the evidence (or 
that the evidence may be suspect). 

Dependency A value between 0 and 1 related to the amount of overlapping 
confidence between two or more sibling hypotheses. 

ESL Evidence Support Logic, an approach to analysing confidence in 
hypotheses based on available evidence. 

Face Value of 
Evidence For 

This field only becomes available when using the advanced evidence 
input controls.  It can be considered a "best estimate" for whether the 
hypothesis is true and should be set such that the face values of 
evidence for and against sum to unity.  The evidence coverage and 
quality fields can then be used to express the uncertainty in the chosen 
face value. 

Face Value of 
Evidence Against 

This field only becomes available when using the advanced evidence 
input controls.  It can be considered a "best estimate" for whether the 
hypothesis is false and should be set such that the face values of 
evidence for and against sum to unity.  The evidence coverage and 
quality fields can then be used to express the uncertainty in the chosen 
face value. 

Hypothesis An assertion to be evaluated, represented as a node in the tree.  
Supported or refuted by lines of reasoning based on evidence. 

Leaf Hypothesis This is the only class of Hypothesis for which Confidence in the 
available evidence can be input by the user.  Leaf hypotheses are found 
at the lowest level of the tree.  There can be many leaf hypotheses. 

Necessity Indicates that confidence in the truth of a hypothesis is necessary for 
confidence in its parent, irrespective of the confidence provided by its 
siblings, or alternatively that confidence in the falsehood of a hypothesis 
is necessary for confidence in its parent irrespective of the confidence 
provided by its siblings. 

Over-committed 
confidence 

Positive value ≤1, that measures the overlap between confidence that a 
hypothesis is true and confidence that the hypothesis is false.  It is a 
measure of overconfidence in judgments of confidence for and / or 
confidence against a hypothesis.  Numerically it is represented as: 

 

confidence for + confidence against - 1, 

 

where confidence for and confidence against are each represented on a 
numerical scale of 0 to1 and confidence for + confidence against >1. 
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Term Definition 

Parent Hypothesis A hypothesis with one or more children (i.e., any but a leaf hypothesis). 

Propagation The calculation of confidence in parent hypotheses by combining the 
confidence in its children based on a user-specified ESL 
parameterisation. 

Residual 
Uncertainty 

Residual uncertainty is defined numerically as: 

 

1 – confidence for – confidence against 

 

and takes values in the range -1 to 1.  When positive it represents 
uncertainty arising from lack of evidence or from lack of confidence in 
the available evidence.  In this scenario, it is also known as 
uncommitted confidence.  If the residual uncertainty is negative then this 
corresponds instead to a conflict, in which case it is also referred to as 
over-committed confidence.  

Root Hypothesis The root hypothesis is the one at the highest level of the tree and has no 
parent hypotheses.  After confidence propagation, the root hypothesis 
indicates the confidence and residual uncertainty in the main hypothesis 
associated with a decision. 

Sibling 
Hypotheses 

Hypotheses that share the same parent. 

Sufficiency A numerical value between 0 and 1 indicating the degree to which 
judgments of confidence in a child hypothesis (for or against) contribute 
to confidence that the parent hypothesis is true (for) or false (against).  
A sufficiency answers the question “In the absence of any other 
knowledge; if the hypothesis were known to be true or false, then how 
confident would you be that the parent hypothesis is true or false?” 

Tree Graphical representation of a hierarchical hypothesis model. 

Uncommitted 
confidence 

Positive value ≤1, indicating the extent to which confidence in the truth 
or falsehood of a hypothesis cannot be assigned owing to lacking 
evidence.  Numerically it is represented as: 
 

1 – confidence for – confidence against, 
 

where confidence for and confidence against are each represented on a 
numerical scale of 0 to1 and confidence for + confidence against <1.  
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